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Preamble

1.1. Overview

Beginning as an Open Source project in the year 2002, eXo is well-known as the industry's first

Java portlet container. With the aim of dominating the potential portal market through robust and

easy-to-use applications, eXo Project has succeeded in attracting consumers in the whole world.

Exo has actually opened the floodgates to various options in many markets, and customers have

been choosing eXo as the best method for their success.

The eXo Platform™ software is a powerful Open Source that corporates portal and content

management system. Users of the platform have a customized single point of access to the

company's information system and resources.

The foundation for eXo Platform 3.0 is eXo Core Services, a powerful set of REST-based

services for rapid website development, content management and gadget-based development.

eXo Extended Services are also a part of the eXo Platform 3.0, running on the top of eXo Core

Services to enable easy development of rich, user-centric web applications.

eXo Content is one of eXo Core services. It provides a set of services to extend portal-based

applications with Enterprise Content Management (ECM) capabilities. Document Management

System (DMS) features make it easy to catalog and organize enterprise content and with powerful

Web Content Management (WCM) services to quickly build dynamic, content-rich websites.

1.2. Why Use Site Publisher

If you are looking for a powerful tool and strategies in managing website and contents, eXo Content

is what you need. eXo Content is designed to provide webmasters who manage websites the
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way to maintain, control, modify and reassemble the content of a web-page easily and effectively.

All components of your website can be organized, reconstructed easily, which helps you keep

your website under the control. eXo Content really brings interesting experience for all users and

changes their way of thinking about website. The followings are key features of eXo Content:

Website Creation

Fast Setup:

Setup a new site in just a few clicks with an intuitive user interface and template features.

Navigate, Preview and Publish Content:

Navigate through page content in either a single content viewer or the list content display,

quickly preview page content or work on new content in draft mode and publish at anytime.

Templates:

Create websites from existing templates and themes, or create new templates with a

consistent look-and-feel across a single site.

In-Site Edition

The integrated rich text editor allows non-technical users to edit the pages they are in charge

of in an intuitive way.

Web Content Organization

Web-Based Administration:

Use a web browser to manage sites remotely, no local administration software is required.

Manage Multiple Websites:

Manage and control every site in one place.

Media Library:

Upload media to the library, publish, reuse and update all available media content across

multiple websites.

Content Search:

Search content and documents using categorization and tag features.

Broken Link Detection:

Know how many broken links are present and how many are functional with ease.

Versioning and Rollback:

Easily rollback a website's content with automatic versioning.

SEO and Friendly URLs:

Search Engine Optimization (SEO) is simplified for editing meta tags and more. Content has

its own specific URL for easier bookmarking and improved SEO.
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Configuration for Deployment on Web Farms:

Advanced deployment rule for scalable, three-tier web application architecture with partitioned

replicated deployment.

Capture and Manage Documents

Kofax Plugin:

Collect paper documents, forms, invoices and other unstructured documents and convert into

accurate and retrievable information, stored in the eXo JCR.

Access Control List:

Access Control List: Validate the current session's permissions to add nodes, set properties,

remove or retrieve items. Define actions to launch the next step in a process, or to invoke

any "coded" action required.

Workflow:

Specify processes for document collaboration and validation.

Record Management:

Track the status of content completion and control document storage lifecycles.

Store and Access Documents

JCR:

eXo JCR allows applications to access or manage files independent of their location, and also

provides advanced features such as unified access control, versioning, indexing and more.

Automatic Backup:

Define and automate tasks to save documents as required.

Web Interface:

Access documents in an intuitive and user-friendly web interface.

Microsoft and OpenOffice Plug-ins:

Microsoft and OpenOffice plug-ins give users the freedom to work on documents in their

preferred document editing program.

And More...  eXo Content also provides other powerful tools to manage an build content-rich

websites such as CSS, Java Script and RSS support, advanced document management tool,

collaboration tools, etc. All features is to meet your requirements for the purpose of easy site

management, cost reduction in managing multiple sites in only one place.

1.3. About This Document

The intended reader of this user guide are users using eXo Content. This guideal will explain

all the basic and advanced features that eXo Content provides in managing websites and site
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content. It gives in-depth examples and easy explanations of eXo Platform technology that allows

the webmasters to create and manage a very fast and powerful website.

With this guide you will:

• learn the basic terminologies used in eXo Content.

• know how to create, manage and publish Site content.

• know how to manage Web pages, set up a website, etc.

In this guide, we will use the following accounts (username/ password) throughout the guide:

• root/ gtn: This account is for users as Administrators who have the highest right on the platform.

• mary/ gtn: This account is for a publisher who can write contents but also can create new pages

or edit them in the current site.

1.4. References and Related Sources

Information

• eXo Home Page [http://www.exoplatform.com/]

• eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/]

Support

• Forums [http://forums.exoplatform.org/]

• FAQs [http://faq.exoplatform.org/index.html]

Downloads

• eXo Content [http://www.exoplatform.com/company/public/website/platform/exo-core-services/

exo-content]

• eXo Development Tools [http://www.exoplatform.com/company/public/website/platform/exo-

core-services/exo-development-tools]

• Gatein Portal Framework []

• eXo Collaboration [http://www.exoplatform.com/company/public/website/platform/exo-

extended-services/exo-collaboration]

• eXo Knowledge [http://www.exoplatform.com/company/public/website/platform/exo-extended-

services/exo-knowledge]

http://www.exoplatform.com/
http://www.exoplatform.com/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://forums.exoplatform.org/
http://forums.exoplatform.org/
http://faq.exoplatform.org/index.html
http://faq.exoplatform.org/index.html
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
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• eXo Social [http://www.exoplatform.com/company/public/website/platform/exo-extended-

services/exo-social]

Resource Center

• Video demos, tutorials, webinar archives, features and benefits tables and more [http://

www.exoplatform.com/company/public/website/resource-center]

http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
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Overall Introduction

2.1. eXo Content

Web Content Management (WCM) is the technologies used to Capture, Manage, Store,

Preserve, and Deliver content and documents. It especially concerns content imported into or

generated from within an organization in the course of its operation, and includes the control of

access to this content from outside the organization's processes.

The WCM users can manage both structured and unstructured content, so that an organization,

such as a business or governmental agency, can more effectively meet business goals (increasing

the profits or improve th organizational process with efficient use of budgets), serve its customers

(as a competitive advantage, or to improve responsiveness), and protect itself (against non-

compliance, law-suits, uncoordinated departments or turnover within the organization).

WCM improves your operational productivity and efficiency. It enables you to transform

unstructured content into structured content through the process of capturing, storing, managing,

preserving, publishing and backing up while securely distributing it. The WCM portlet gives you

a portal solution that can help you achieve these processes and leverage your business content

across all formats for competitive gain. It also provides an environment for employees to share

and collaborate on digital content and delivering a comprehensive unified solution with rich

functionalities. Every components of your website can be organized, reconstructed easily, which

helps you keep your website under control.

Document Management System (DMS) - an extension of eXo Content is used to store, manage

and track electronic documents and electronic images and allows documents to be modified and

managed easily and conveniently by managing versions, properties, and more.

2.2. Site Content Structure

Creating a site is a quick process, but deciding what content to put in the site and how to organize

it will take a lot of time. Thus, to mange a site more easily and more effectively, a site always has

a specific structure as follows:
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The Site Content are stored in collaboration workspaces of Java Content Repository (JCR).

Details:

CSS

This file is used to define the presentation of your entire site such as: font, color, size, etc.

Documents:

All documents, which are used in a site will be stored in this folder.

JS

A programming script used on the site. This file is used to make a web page more animate

and dynamic in terms of graphics and navigation.

Links:

This folder stores all links used in the site.

Media:

This folder includes three sub folders:

Audios:

Store all sound files used in a site.

images:

Store all images, pictures used in a site.

videos:

Store all video files used in a site.

Web content:

This folder is used to store the documents which present main content (texts images,

hyperlinks, audios and videos) of the site.
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2.3. Web Content

2.3.1. Web Content

Web Content is the textual, visual or aural content that is encountered as part of the user

experience on a website. It may include other things such as texts, images, sounds, videos and

animations.

2.3.2. Web Content Structure

The Web content may include various elements. Thus, to create and manage the Web content

more effectively and dynamically, each Web Content also has a specific structure:

Main content:

It contains all key content such as: texts, images, links, tables, etc.

Illustration:

It contains an image that is used as an illustration for the content. Additionally, a summary

also can be added to come with this image.

default.css:

It contains CSS data which is used to present the web content such as: layout, font, color,

and more.

default.js:

It contains JS data which is used to make web content more animating and dynamic.

2.4. Terminologies

2.4.1. Repository

A repository is a place where contents are stored and maintained. The content repository is:

• A place where contents are stored.

• A place where digital data are stored.

• Accessible to the user without having to travel across a network.

2.4.2. Workspace

A content repository is composed of a number of workspaces. Workspace is a term used by

several software vendors for applications that allow users to exchange and organize files over the

Internet. In our case, the content repository consists of more than one workspace. The “repository”

repository contains multiple workspaces, including : system, backup and collaboration workspace.
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System workspace:

is used to reserve “system folders”.

Backup workspace:

The backup process depends on the published content timestamps, each published document

has a duration for which it can be published and when it exceeds the timestamps, it will be

automatically archived to the backup database. This workspace is mostly used when using

the Workflow based content publication lifecycle.

Collaboration workspace:

Allows users to validate and manage documents. This is the central place to store and edit

contents and media.

2.4.3. Drive

A drive can be understood as a shortcut in the content repository. It enables administrators to limit

visibility of each workspace for groups of users. It's also a simple way to hide the complexity of

the content storage by showing only the structure that makes sense for Business users.

More specifically, a drive consists of :

• a configured path from where the user will start when browsing the drive.

• a set of allowed views that, for example, will allow to limit the available actions (such as the

edition or creation of content while being in the drive).

• a set of permissions to limit the access (and view) of the drive to a limited number of people.

• a set of options to describe the behavior of the drive when users browse it.

2.4.4. Node

A node is an abstract basic unit used to build linked data structures, such as linked lists and trees,

and computer-based representation of graphs. Nodes contain data and/or links to other nodes.

Links between nodes are often implemented by pointers or references.

A node can be thought of as a logical placeholder for data. It is a memory block which contains

some data unit, and optionally a reference to some other data, which may be another node that

contains other data. By linking one node with other interlinked nodes, very large and complex data

structure can be formed.

2.4.5. Version

Versioning means that at any given time the node's state can be saved for possible future recovery

and the action of saving called 'checking in'. A workspace may contain both versionable and non-

versionable nodes. A node is versionable if it has been assigned a mixin type mixin: versionable;

otherwise, it is a nonversionable node. A version exists as a part of a version history graph that

describes the predecessor/successor relations among versions of a particular versionable node.
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Software versioning is the process of assigning either unique version names or unique version

numbers to unique states of computer software. Within a given version number category (major,

minor), these numbers are generally assigned by increasing order and correspond to new

developments in the software. At a fine-grained level, revision control is often used for keeping

track of incrementally different versions of electronic information, whether or not this information

is actually computer software.

2.4.6. WebDAV

WebDAV stands for Web-based Distributed Authoring and Versioning. It is a set of extensions

to the Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage

files on remote World Wide Web servers.

The protocol was to make the Web a readable and writable medium. It provides functionality to

create, change and move documents on a remote server (typically a web server or "web share").

This is useful for, among other things, authoring the documents which a web server serves, but

can also be used for general web-based file storage that can be accessed from anywhere.

2.4.7. Podcast

A podcast is an audio file that you can download and listen to on your computer or a portable

MP3 player such as an iPod. The word itself comes from the combination of two other words:

iPod and broadcast.
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2.4.8. File Plan

The file plan is the primary records management planning document. Although file plans can differ

across organizations, their typical functions are to:

• Describe the kinds of items the organization acknowledges to be records.

• Describe what broader category of records that the items belong to.

• Indicate where records are stored.

• Describe retention periods for records.

• Delineate who is responsible for managing the various types of records.

2.4.9. Symlink

Symlink is a special file containing a reference to document or folder. By using symlinks, you can

easily access specific nodes (target) that symlinks point to. In Content Explorer, a symlink has a

small chain symbol next to its icon:



Chapter 3.

13

Get Started

3.1. Account

3.1.1. Register an account

To register a new account on the portal, do as follows:

Procedure 3.1.

1. Go to the portal by inputting the URL in the address bar (e.g: http://localhost:8080/portal/

public/classic).

The anonymous homepage will appear:

2. Click the Register link on the top of the site, the Register form will be displayed:

http://localhost:8080/portal/public/classic
http://localhost:8080/portal/public/classic
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(*) required

The Account Setting information includes:

Table 3.1.

Field Information

User Name The user name that is used to login into the

system. It must be unique. The user name

must be started with a character.

Password The security characters are used to login. It

must have at least 6 characters.

Confirm Password The re-typed password above. The

password in Password field and this field

must be the same.

First Name Your first name

Last Name Your last name

Email Address Your email address. It must have a right

format: username@abc.com

3. Input values for the fields in this form.

4. Click the

icon to search and check if the inputted user name is available or not.

5. Input values in the fields of User Profile tab, including: Profile information, Home information

and Business information.
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6. Click Save to register a new account, or Reset to renew all inputted values. There will be

an alert message, and you cannot add a new account successfully if at least one of these

cases occurs:

• User name is existing or invalid.

• Password has less than 6 characters.

• Password and Confirm Password are not the same.

• Email Address has invalid format.

• Required fields are empty.

After adding a new account, contact with the administrator to get the confirmation.

Email

You should enter your email address exactly because when you forget username

or password, you can recover it by using this email address.

3.1.2. Sign In

This function enables you to go into WCM in the private mode.
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Procedure 3.2. Sign in

1. Go to the WCM in the public mode by inputting the URL in the address bar (e.g: http://

localhost:8080//portal/public/classic/).

2. Click the Login link at the top of the home page. The Sign in form will appear:

3. Input your registered User name and Password.

4. Click Sign in to accept, or Discard to exit from the Sign in form.

Table 3.2. Options

Option Information

User name To input the registered username.

Password To input the password of your username.

Forgot your User Name/Password To retrieve the forgotten user name or

password when you forget.

Sign in To sign into the eXo Portal with the inputted

user name and password.

Discard To close the Sign In form without any

changes.

If the User Name does not exist or the inputted User name/Password is invalid, there will be

an alert message that requires users to input right values. The page will be redirected to the

private security checking mode.

To login again, enter User Name and Password again.

After signing in, you will be redirected to the authenticated homepage like the illustration.

http://localhost:8080//portal/public/classic/
http://localhost:8080//portal/public/classic/
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3.1.3. Sign Out

The function lets you get back to the anonymous portal. It ends your current portal session.

To sign out, click the Logout link on the right access banner:

or click eXo > Sign Out from the menu:
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3.1.4. Retrieve user name/password

If you forget your account or password, you can recover them by doing as follows:

Procedure 3.3.

1. Click the link Forgot your User Name/Password? in the Sign in form.

This form offers two options:

Forgot my password:

If you forgot your password, you need to select this option.

Forgot my username:

If you forgot your username, you need to select this option.

2. Select one of these two options in this form. The selected option will be shown:

If the Forgot my password option is selected the form to recover the password appears:

If the Forgot my username option is selected, the form to recover the user name appears:
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3. Enter your username or email in the corresponding form.

4. Click Send to send the inputted values.

Once information has been sent, you will receive an email with your User name/ Password

in your email address that you registered.

• If you forget User Name: when a username is retrieved, your old username is restored and

can be reused and a new password is also sent to your email with the old username.

• If you forget old password: a new password will be set (as temporary, then you will be

directed to change the password for the next time you sign in).

3.1.5. Change Account Information

The function enables you change your account information, such as your profile and password.

Procedure 3.4.

• The first thing to do is to directly click your own account name.

The Account Profiles tab will appear:
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Procedure 3.5. To Change Account Profiles

1. Select the Account Profiles tab.

This tab displays your current basic information.

2. Change your First Name, Last Name and Email. You cannot change your User Name.

3. Click Save to accept changes.

Procedure 3.6. To change your Password

1. Select the Change Password tab.
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2. Input your current password to identify that you are the owner of this account.

3. Input your new password, it must have at least 6 characters.

4. Input your password again in the Confirm New Password field.

5. Click Save to accept changes.

3.2. Change The Display Language

The priority order of display language is shown to the following order:

1. User's language

2. Browser's language

3. Portal 's language.

Thus, to display your preferred language, you should pay attention to this order to change the

language type appropriately.

Procedure 3.7.

1. Move the mouse on eXo | Change Language on the top left corner of the portal:
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The Interface Language Setting form appears:

2. Select the another language in the list. The currently selected language will be marked with

the

icon.

3. Click Apply to change the display language temporarily, and wait few seconds to take effect,

or click Cancel to quit without any changes.

3.3. Change the skin of the current site

The eXo skins are attractive user interface styles for displaying a portal. Each skin has its

own characteristics with different backgrounds, icons, and more. To use the portal easily and

effectively, you are allowed to change the skin of the current site.

Procedure 3.8.

1. Move the cursor to eXo | Change Skin item in the drop-down menu:

The Skin Setting form appears.
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2. Select the skin you want by clicking its name.

3. Click Apply and wait a few seconds to take affect.

These actions can be done by users who have the right to use the administration bar with a

personal preferences menu.
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Basic Actions
These actions are for all registered users after they have logged in the accounts.

4.1. View a site

In eXo Content, we use the 'Website' term which is equivalent to the 'Portal' term. So, viewing a

portal means viewing a website. You can select the site that you want to view by selecting the site

name in the drop-down menu on the Administration bar:

The main screen of the site will appear like the illustration below:

Administration bar which contains administration functions related to portals (websites).

Banner which contains slogan, logo, icon used in the website.
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Navigation bar which helps users to visualize the structure of the website and provide quick

links to different pages.

Home page which is the main page of the website. This is the default page that is displayed

first when you visit the website.

Footer of the web site. It can be texts, or image that is displayed at the bottom of the web site.

It provides information about author/institutional sponsor, revision date, copyright and more.

4.2. Print a Web Content

Users can easily print any content in a site by following these steps:

Procedure 4.1.

1. Click Read more to read all the content of a document or an article in a site.

2. Click the Print button, the Print Preview page will be displayed on another tab.

3. Click Print to print the content of this page or Close to close this tab without printing.

4.3. Contribute Content

4.3.1. Edit Mode

A site in eXo Content has two modes (Published mode and Edit mode) which is specific for editing

site and viewing site. You can easily switch between these modes by selecting in the drop-down

list at the top left corner.
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• Edit mode: In this mode, you can edit all contents of the current site. When hovering the mouse

over contents, you can see edit icons which enable you to quickly edit these contents. You can

take advantage of this feature to submit contents to a page.

• Published mode: In this mode, you only can view the current site without editing the contents

of the site.

When you login to a site, by default, the page is in the published mode, you cannot see any quick

edit icon and cannot edit site contents at this time:

When a page is switched to the Edit mode, you can see quick edit icons on the site contents when

mousing over them.

For single content viewer (SCV), you can see the current state of the content, the Edi Content

icon and References icon.
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For content list viewer (CLV), you can see the current state of the content, the Edit Content,

References icon, the Add Content icon and the Management Content icon.

4.3.2. InContext Editing

InContext Editing allows you to edit content "in context" rather than having a WYSIWYG editor

pop-up over the top of the page. This feature makes page editing a much more user intuitive

process, with the new content automatically taking on the previous contents.

To use InContext Editing, turn on the Edit Mode.

4.3.2.1. Add Content

Adding a new content by InContext Editing is enabled for the content list viewer.

Do the following:

Procedure 4.2. Add a new content

1. Turn on the Edit Mode > hover the mouse to the CLV that you want to add a new content in.

2. Click the Add Content icon on the CLV.

You will be redirected to the Content Explorer with a new document form for you to write

a document.



InContext Editing

29

3.
Click

to open the template list and select one .

4. Fulfill all the fields in the form. See the part Section 4.6.4.2, “Add a document” to know how

to add types of document.

5. Click Save as Draft to save the document in a folder of the Collaboration drive or Close to

quit the form without creating the document.
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Note

Saving a document in which folder of the Collaboration drive depends on the path

you choose in Section 4.3.2.4, “Preferences”.

4.3.2.2. Edit Content

You can edit any contents on the homepage for SCV and CLV with InContext Editing. For CLV,

you only can edit each content in it.

Do the following:

Procedure 4.3. Edit a content

1. Turn on the Edit Mode > Hover the mouse to the content you want to edit.

2. Click

on the right conner of the content you want to edit. You will be redirected to the Content

Explorer with the document form form for you to edit.

3. Edit the content > Click Save as Draft to save the content or Close to quit the form.
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4. Click

to return to the site and in the Edit Mode, the content in the state "draft" with its modification

is visible.
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Note

When you turn on the Published Mode, you cannot the edited content. To see it in

the Published Mode, you must publish it. See Section 4.3.3, “Publication Process”

to know how to publish a content.

4.3.2.3. Manage Content

With InContext Editing, you can easily manage a content list on the homepage. You can add a

new content in the list.

Do the following:

Procedure 4.4. Manage Content

1. Turn on the Edit Mode > the Manage Content icon of the content list viewer that you want

to manage on the homepage.

The browser will redirect to Content Explorer:
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2. Click Add Document on the action bar to add a new content to the folder containing all the

contents in the content list viewer.

3. The form to add a new content appears. Do the same steps as the part Section 4.3.2.1, “Add

Content”.

4.3.2.4. Preferences

Preferences enable you to edit contents in the single content viewer (SCV) and the content list

viewer (CLV), reset the display of the contents in SCV and CLV and publish contents.

Content Detail Preferences. To edit the single content viewer do the following:

Procedure 4.5.  Edit Content Detail Viewer

1. Turn on the Edit Mode > Select the Preferences icon of a single content viewer.

The Content Detail Preferences dialog appears:
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Details:

Content Selection: Select the path of the content that you want to show by clicking

.

Display Settings: Allow configuring Title, Date and OptionBar visibility.

• Show Title: Specify whether the title of the content is displayed or not.

• Show Date: Specify whether the date of the content publication is displayed or not.

• Show Option Bar:Show or hide the Option bar used to show the print link.

Print Setting:

• Show in page: The content is shown the page.

• with: Parameters contains the content path.

Advanced panel: When clicking on this link, the Advanced panel will be shown. If Contextual

Content property is "Disable", the Advanced panel is closed by default .The content should

enable “dynamic navigation” that interprets the URL and shows a content.
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Note

Click

to see a quick help panel for each section.

2. Click the plus icon next to the Content Path to re-select another content. The Select Content

dialog appears: selectcontent

3. Choose a folder on the left panel and a content in the folder on the right panel. The content

chosen will be displayed in the Content Path field.

4. Tick in the Show Title box, the Show Date and the Show Option bar box if you want to

display the title of the content, the date of the content publication and the print button like

the illustration below:
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5. In the Print Setting part, click

and the UIPageselector dialog appears, you will see Printviewer.

Click the Print button, the content is opened in the print viewer page.

URL: http://localhost:8080/ecmdemo/private/acme/printviewer?content-id=/repository/

collaboration/sites%20content/live/acme/web%20contents/site%20artifacts/

Introduce&isPrint=true

In which:

• printviewer?: the print viewer page of the content.

• content-id: the parameter containing the content path.

6. Click Save  to save all the changes or Cancel to quit the dialog without any changes.

Content List Preferences. To edit the single content viewer do the following

Procedure 4.6. Edit Content List Viewer

1. Turn on the Edit Mode > Select the Preferences icon of a content list viewer.
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The Content List Preferences dialog appears:
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Details:

Table 4.1.

Mode This mode is to select web content for list

viewer. There are two modes:

By Folder: This mode allows you to select a

content folder in the Folder path field.

By Content: This mode allows you to select

by the content in a specific folder in Folder

path field.

Folder path The path to a location of a folder that

contains the content.

Order by The field is selected to sort content in the

list viewer. You can sort content by Title,

Date created or Date modified in ascending

or descending order.

Header The title for all content that are listed in List

Viewer.

Viewer template The template is used to view content list.

Paginator template The template is used to view each content in

list.

Items per page The number of items will be displayed per

page.

Show image The option is to show or hide the illustration

of each published web content/document.

Show summary The option is to show or hide the summary

of each web content/document.

Show header The option is whether to show a header or

not.

Show refresh button The option is whether to show the refresh

button at the left bottom of this page or not.

Show title The option is to show or hide title of each

published web content and/or document.

Show date created The option is to show or hide the created

date of each published web content/

document.

Show link The option is to show or hide the link of web

content and/or document.
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Read more The option is to show or hide the Read more

to read all the content of a web content and/

or document.

2. Browse the documents/ web content of an available site by clicking

next

to the folder path field.

3. If you select the By folder mode, select an available site on the left, then select a folder that

contains contents (documents and/or web content) on the right by clicking the folder.

If you select the By content mode, select an available folder from the left panel, all content in

this folder will be listed on the right panel. Click a content on the right that you want to add to

the content list. A message informs that you have successfully added it in List Content. The

selected content is listed in List Content.

4. Enter a header for the content list in the Header field if you want.

5. Select a template to display the content list in the template list.

6. Tick/untick some options that you want.

7. Click Saveto save all the changes or Cancelto quit the dialog without any changes.

4.3.3. Publication Process

After a new content is created, it is saved as draft and you can easily to publish it on your site.

The publication process consists of four steps:

Request approval > Approval > Stage > Publish

If you do not have the right to approve or publish a content, so when you want to publish your

content, you must send your approval request first.

If you have the right to approve or publish a content, you do not need to send a request approval.

You can yourself publish it with the Stage step immediately.

• Request approval: When a new content is created, it must be approved before publishing by

clicking Request Approval on the action bar of the Content Explorer or clicking Pending in

the Manage Publication form:
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• Approve: To approve a content, click Approve on the action bar of the Content Explorer or

click Approved in the Manage Publication.

• Stage: Stage enables you to publish a content in a period. After selecting the publication

schedule for the content, it will be automatically published as the schedule.

To publish content for a stage, click Stage > Click From/ To to open a mini calendar > Select

the date to publish.

To publish your content forever, you should not to set time in the To field.
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• Publish: A content will be published when you have completed the Stage step.

Note

You will see a list of draft contents, pending contents (that are waiting to be your

approval if you have the approval right) and contents that will be published at

the bottom of the Content Explorer. Click them to review, approve or publish.

4.4. Content Inside Categories

You can create new contents in any folders or directly in a CLV with Incontext Editing. However,

creating contents inside a category helps you easily and quickly manage and publish them.

4.4.1. What is a Category in eXo Content?

Categories are used to sort and organize documents to ease searches when browsing documents

online. After creating a document, you should categorize it by adding it into a category. You should
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directly create a document in a category, then the document is automatically created a link to it in

the category. When you browse the category, it will be possible to find the referenced documents

and display them as if they were children of the category node.

Categories are stored in the JCR itself .

4.4.2. Create a Content

This section will show you how to create a content in a category.

Do the following:

Procedure 4.7. Create a content

1. Go to Group > Content Explorer > select a category in a drive. For example, select Acme

drive as the following illustration.

2. Click the Add Document button to create a new content. See Section 4.6.4.2, “Add a

document” to know how to add a new content. The new content is a symlink.

Click the symlink to view the content.
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4.5. Dynamic Navigation

Dynamic Navigation enables you to get a parameter to configure the portlet by URL. It means that

the URL containing the content path can be dynamically changed.

This section shows you how to use Dynamic Navigation in eXo Content.

Do the following to access Dynamic Navigation:

Procedure 4.8. Access Dynamic Navigation

1. Turn on the Edit Mode > hover the mouse to SCV or CLV and select the Preferences icon.

If you select the Preferences icon of SCV, the Content Detail Preferences form displays.

If you select the Preferences icon of CLV, the Content List Preferences form displays.

2. Click the Advanced panel in the Content Detail Preferences form/ the Content List

Preferences form.

The Dynamic Navigation will display.

Dynamic Navigation in SCV

Details:
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Table 4.2.

Contextual Content • Disable: It means a single content will be

opened by an URL containing the Content

Path.

• Enable: This portlet is configured with

the provided parameter (content-id by

default).

By This parameter is the key in the URL to let

SCV know which really is the path in the

current URL. It is editable when Contextual

Content is Enable.

For example, open a single content with the Content Path "ACME Introduce". The URL of

the content is the following:

URL: ... /ecmdemo/private/acme/printviewer?content-id=/repository/collaboration/sites

content/live/acme/web contents/site artifacts/Introduce&isPrint=true

Dynamic Navigation in CLV
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Details:

Table 4.3.

Contextual Folder • Disable: It means a single content will be

opened by an URL containing the Folder

Path (for CLV)

• Enable: It means the path of content list

(Folder Path in the Content Selection path)

can be dynamically changed by URL.

By This parameter is the key in the URL to let

CLV know which really is the path in the

current URL.

Show in page A single content in CLV will be shown in a

selected page. You can choose any page but

you should take one with a Content Detail
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Portlet. The Content Detail Portlet should

enable “dynamic navigation” that interprets

the URL and shows a single content.

With This parameter is the key in the URL to let

SCV know which really is the path in the

current URL.

4.6. Content Explorer

4.6.1. Access Content Explorer

This page is used to manage all documents in different drives. This is really the flexible way

because you can do through the Internet anytime and anywhere. By default, anyone can access

Content Explorer but the performing actions on Content Explorer depending on the role of each

user.

Procedure 4.9.

• Go to Group > Content Explorer on the administration bar:

A list of all drives organized in groups: Personal drives, Group drives and General drives in

the Content Explorer displays:



Access Content Explorer

47

Personal drives:

Personal drive is the working space of a user. If you want to do in private, select the

Private drive, no one else can access or get your private resources. If you want to create

resource and share with others, work in the Public drive.

Group drives:

The drive of a group is the working space of users in that group.

In this example, the user "root" joins in three groups : "executive-board", "administrators"

and "users" so he has right to access these group's drive.
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General drives:

This is the working space for everyone but your access right in different drives depends

on your role. If you access as administrator role, you can see all drives; otherwise, if you

access as web contributor role, you can see some drives only.

4.6.2. Drives

4.6.2.1. Private drive

Private drive contains personal data of registered users. Hence, only these individuals can access

data in this drive type.

By default, there are some initialized folders to store private user's resources.

•

By selecting the Actions tab, you can:

• Create a new folder

• Create a new document

• Upload file from your computer

• Add Sym Links
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• Overload Thumbnails

• By selecting the Collaboration tab, you can:

• Watch/Unwatch a document.

• Add tags for a document.

• Set multi-display languages for document.

• Vote for a document.

• Comment for a document.

• By selecting the Search tab, you can:

• Do the simple search

• Do the advanced search with more constraints, add new query to search

• Do search by existing queries.

• In addition, you can:

• Setup your browsing preferences

• Cut/paste, Copy/past, Delete a node

• Lock a node

• Rename a node

• Use the view WebDAV function to view document content.

• Download documents (folders) to your machine.
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4.6.2.2. Public drive

With the Public drive, there is no initialized folder but you can create by yourself.

In the Public drive, you also can take actions like in the Private drive.

4.6.2.3. Drive of a specific group

By default, there are two initialized folders but you also can add more and take actions like in

Private drives. Only users in a specific group can access its drive.

4.6.2.4. Shared Users Space drive
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By default, there will be a list of all existing users, each user has a folder named with his username,

that includes two sub folders (private and public). You can see both your private and public folders

here but you only can see the public folder of other users.

• In this drive you can:

• Perform all actions that you can do in your private drive.

• View nodes from public folder of others

• In this drive you cannot:

• Add a folder/document in a root node

• Add a folder/document in a folder named by other users and in child nodes of this folder.

• Add folders/documents in a folder named by your username (e.g, you cannot add a folder/

document in the folder "root"), but you can do in its child nodes "public" and "private".

• Rename a default folder

• Lock folders named by a user

• Delete a default folder

4.6.2.5. Show/hide the sidebar in a drive

The side bar is used to show nodes like a tree or show the related documents, tags, clipboard

and saved searches.

You can show/hide the side bar in two ways:

1. Procedure 4.10. Method 1

1. Click

to open the Preferences:
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2. Untick the Show sidebar check box > Save.

The drive will be displayed like the illustration below:

3. To show the side bar, tick the Show sidebar check box in the 'Preferences'.

2. Procedure 4.11. Method 2

1. Simply click the border of this sidebar to hide it as the illustration below:

2. Click that border again to show the sidebar back.

4.6.3. Views

There have many drives in the Content Explorer. Each drive has some views that enable you to

look at data in the drive in a particular way. Each view has some tabs and each tab contains some

functions (or called actions).

eXo Content supports you four ways to view nodes in a specific folder and show actions of

corresponding tab on the Actions bar.
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View Types

The number of View types depends on what drive you are browsing.You can

manage the view types in the WCM Administration. See Section 5.3.2.3, “Manage

Views” for details

4.6.3.1. Admin view

In this view, each item in the list includes following information: Name, Date Created, Date

Modified, Owner, Versionable and Auditing. These information will help you manage nodes easily.

You also can sort nodes basing on node information

by clicking the label of corresponding column. The

indicates that nodes are ordered in ascending order and on the contrary, the

icon means nodes are in descending order.

4.6.3.2. Icons View

In this view type, nodes in a specific folder will be viewed as icons. The name of each node will

be shown under its icon.
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4.6.3.3. Thumbnails View

With Thumbnails view, nodes in a specific folder are viewed as icons bounded by frames. Name

of each node is shown under its icon.

If nodes are image files, their thumbnails will be shown like the screenshot below:

Especially, in this view, you can overload thumbnail image for node. For example, if you want to

add thumbnail image for Digital Assetsfolder, do as follows:

Procedure 4.12.

1. Select a folder (on the left or right panel) that you want to add a thumbnail image.

2. Click

to open the Add thumbnail image form:

3. Select an image used as a displaying icon for the selected folder by clicking the

Browse...button.

4. Complete adding a thumbnail image by clicking Save. This node will be stored in a

exo:thumbnails folder.
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5. Back to the parent folder (folder Pictures in this example) that contains the selected folder

to see a icon used to display:

4.6.3.4. Cover Flow View

You can understand this view as a dynamical view because it brings the side-scrolling view to

nodes in a folder. In this view, when a node is selected, its name is set with bold effect to more

outstanding than others.

If nodes are pictures, they are shown like:

If nodes are documents or folders, they are displayed like the illustration below :
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To move from one node to another one, you can do any of these ways:

• Use the mousewheel.

• Hold and move the yellow circle button to the left or the right.

• Click the folder/document name that you want to select.

4.6.3.5. Slide Show View

In this view type, pictures in folders are viewed in slide show.

To view pictures in slide show, click the

icon:

If nodes are pictures, they are displayed like the following illustration:
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The Slide show view automatically show all picture nodes, users can control this slide show by

clicking the below buttons:

Table 4.4.

Button Function

Go to the first picture node.

View the previous picture node.

Pause the slide show.

View the next picture node.

View the last picture node.

Continue viewing pictures node.
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4.6.3.6. Timeline View

This view enables users to view all nodes created and uploaded by time. Just click the

icon.

All the nodes that were created and uploaded will be displayed like below:

You can click directly on the node name to view its content in details.

You can also click the

to mark your item as favorite or the

icon corresponding to nodes in order to remove it from favorites.

4.6.4. Actions

Actions are added in tabs in Content Explorer by administrators. Depending on each tab and each

drive you are browsing and your role, you can see which action.

eXo Content consists of many actions. This section shows you how to take all the actions in

Content Explorer.

4.6.4.1. Add Category

This function enables you to add a category for a node.
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Do as follows to add a category:

Procedure 4.13.

1. Choose a node that you want to add a category into.

2. Select

on the action bar and the Add Category form appears:

3. Enter a name for the category in the Category Name field.

4. Click Save to accept creating a new category or Cancel to quit from this form without adding

a category.

4.6.4.2. Add a document

There are several types of document in eXo Content, including File, Article, Podcast, Sample

node, File Plan, Kofax.

The table below outlines which nodes types different document types can be added to. The rows

indicate what the node in the left column can be added to. The columns indicate what the node

at the top can contain.

Table 4.5.

File Article Podcast Sample

node

File

Plan

Kofax

document

Content

folder

Document

folder

File

Article    

Podcast

Sample

node
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File Article Podcast Sample

node

File

Plan

Kofax

document

Content

folder

Document

folder

File Plan   

Kofax  

Uploaded

file

Content

folder

  

Document

folder

  

Note

•

: The corresponding document can be added into.

• A blank entry means the corresponding document can not be added into.

Follow the horizontal, you will know what the node can be added into.

Follow the vertical, you will know what the node can include.

To add a new document, do the following steps:

Procedure 4.14. Add a new document:

1. Select a folder from the left pane that you want to add a new document to.

2. Click

on the Actions bar.
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3. Select the document type (template) that you want to create from the drop-down list (Article

is selected by default).

Each document (except Article) must be added to catagories when created.

Procedure 4.15. Attach files to a document

1. Select a document that you want to attach files to and click

on the Actions bar.

The Upload file form will appear.

2. Enter a name into the Name field, otherwise, the Name field is automatically added with the

name of the file.

3. Click Browse to select the attachment file. You can click

to add multiple files.

4. Click Save to attach the files or Cancel to to quit.

Procedure 4.16. Create a new File document

1. Follow the steps in Add a new document:, to open the Add New Document form, then select

File from the drop-down list for the field Select Template.
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The Add New Document form will be displayed.

2. Input a name for the file document in the Name field. Some special characters cannot be

used in the Name field: @ # % & * ( ) “ ' : ; [ ] {} / !

3. Click the

to see the Mime Type list and select one. There are two types of File document for you to

choose:

• text/html: when creating a text/html File document, you can input value in the Content field

like source code (HyperText Markup Language HTML). After being created, it will generate

the content you want, then you can see both the inputted source code and the generated

content in that document.

• text/plain: after being created, it will display exactly what you inputted in the Content

field.html.

4. Input a value in the Content field:

• text/html: If you want to create a File document

with a source code and generated content, click

in the editor bar. In this mode, only Save, New Page,

Preview icons in editor bar are visible for using. Click the

to preview the generated content.

• text/plain: If you select text/plain type, the content field will be displayed like the following

illustration:
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5. Fulfill all the fields Title ( the title of the File document), Description (some discription about

the document), Creator ( the author of the document) and Source ( the sources of the

document).

Click the plus icon to open more fields.

6. After inputting all required fields, click Save as Draft to accept creating a new file document

or Cancel to quit without saving changes.

After being created successfully, a file document with type text/html will be displayed like the

illustration below:
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Procedure 4.17. Create a new Article

1. Follow the steps in Add a new document: to open the Add New Document form then select

Article from the drop-down list for the field Select Template. (Actually, Article is selected

by default).

The Add New Document form will be displayed.

2. Input the name and the title of the Article in the Name and Title field, some special characters

can not be used in the Name field (@ # % & * ( ) “ ' : ; [ ] {} / !).

3. Input value for the Summary field, and the Content field.

4. Click Save as Draft to accept the inputted values, or Cancel to quit.

After being created, the new added Article document will be like the illustration below:
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The Links is used to list all its related documents. After adding relations for a document, Article

will be displayed. You can click these links to view the content of the related documents.

The Attachments is used to list all its uploaded files/documents that is

attached with the Article. You can remove the attachments by clicking the

.

Instructions to add an attachment are in Attach files to a document.
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Exisiting Names

Document name can be the same as the existing one. When a new document is

created with the same name as other existing document, its name will be added

an index (e.g: test [2])

Procedure 4.18. Create a New Podcast

1. Follow the steps in Add a new document: to open the Add New Document form and select

Podcast from the drop-down list for the field Select Template.

The Add New Podcast form will be displayed.

Table 4.6.

Field Details

Name The name of a document. This field is

required. Some special characters are not

allowed to input in the Name field(@ # % &

* ( ) “ ' : ; [ ] {} / !).

Title The title of a document.

Categories Categories of a document.

Link The link to the source path of the uploaded

media file. This field is required.

Author The author of the uploaded media file.

Explicit It is used to indicate whether or not your

podcast contains an explicit material.

There are two options:

• Yes: an "explicit" parental advisory graphic

will appear next to your podcast artwork

• No: you see no indicator – bank is default

advisory type

Category The category of the uploaded media file,

example: music, film, short clip, etc.

Keyword Keyword allows you to search your podcast

files more quickly. You can use commas to

separate between keywords.

Publish date The date when an episode was released.
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Field Details

Description Information about the uploaded media file.

Mime type The type of the uploaded media file.

Length The length of the uploaded media file.

2. Input values for fields. To upload a media file, click the Browse... button and select the media

file from your machine.

3. Click Save as Draft to finish, or Cancel to quit without saving changes.

Exisiting Names

Document name can be the same as the existing one. When a new document is

created with the same name as other existing document, its name will be added

an index (e.g: test [2])

Once created, a Podcast will appear as so:

Podcasts can be listened to immediately, or transferred to another device.

Procedure 4.19. Create a new Sample node

1. Follow the instructions in Add a new document: to open the Add New Document window

and select Sample node from the drop-down list for the field Select Template.

The Add New Sample Node form will appear.

2. Complete the appropriate fields.

3. To upload an image, click the Browse... button and select an image from your computer.
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4. Click Save as Draft to accept or Cancel to quit without saving changes.

After being created, a new sample node will be displayed like the illustration below:

The Relations area is used to list all its related documents. See Section 4.6.4.15.3, “View

Relations”.

You can click the links to view content of the related document.

The Attachments area is used to list all its uploaded files. See Attach files to a document.

Procedure 4.20. Create a new File Plan

1. Follow the instructions in Add a new document: to open the Add New Document window

and select File plan from the drop-down lis for the field Select Template.

The Add File plan form will appear.

2. Fulfill in the appropriate fields of the tabs in the Add File plan form.

3. Click Save as Draft to accep creating a file plan, or Cancel to quit.
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Tabs in the Add File plan form

The Name tab

Table 4.7.

Field Details

Name The name of the file plan.

Categories The categories of your file plan.

Select the categories for your file

plan by clicking the

button.

File Plan note Note for presenting any other information

for users.
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The Record properties tab

Table 4.8.

Field Details

Record category identifier The alphanumeric or numeric identifier

indicating a unique record category. This

must be a unique ID and if left blank will be

created automatically by the system.

Disposition authority A reference number to the regulations that

govern the disposition.

Permanent record indicator A type of record indicators which should

never be deleted.

Disposition instructions A readable guidelines on how the records

associated with the file plan will be

handled.

Contains records folder The confirmation is about whether the

records folder is contained or not.

Default media type The choice for preset media types which

are made available to simplify the data

entry for the record. The frequently-chosen

value is "electronic" or paper.
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Field Details

Default marking list Handling and classification information

that are printed at the bottom of the

record, such as UNCLASSIFIED or

NOCONTRACT.

Default originating organization This option is to enter the original

arrangement as default which is made

available to simplify the data entry for

the record and to assume that originating

organizations are the same for the

information in the file plan.

Vital record indicator This flag is to allow whether tracking or

reminding you of the record as essential or

not.

Vital record review period The choice for the interval of time between

vital record reviews.

The Process Properties tab:

Table 4.9.

Field Details

Process cutoffs The boolean datatype is used to break a

process. If the process cutoff flag is set in

the file plan, the record is cutoff after the
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Field Details

expiration, or after it has been obsolete or

superseded, depending on the information

in the file plan.

Event trigger The text datatype is an automatic

executing code which is used to tell the

event to perform some actions.

Cutoff period The duration for the record cutoff

performance.

Cutoff on obsolete The record is cutoff when it is obsolete.

Cutoff on superseded The record is cutoff when it is removed or

replaced.

Process hold This boolean datatype is used when a

record process may be held before the

further disposition is handled.

Hold period The duration when a record may be held

after cutoff which is normally measured in

Years.

Discretionary Hold The boolean datatype is used when a

hold may be discretionary, such as after

a command change. So, the discretionary

hold flag allows the records management

module to track these manual checks.

Process transfer The boolean datatype is used to determine

how a record process will be transferred.

Default transfer location The text datatype is used to determine

where a record is transferred by default.

Transfer block size The float datatype is used to determine

in what size blocks for organizational

purposes that is normally measured in

Years.

Process accession The boolean datatype is flagged when a

record which is held permanently must

be ultimately transferred to the national

records authority.

Accession location The text datatype is flagged to specify an

area for the accession transfer.

Accession block size The text datatype is flagged to determine

the blocks size for organizational purposes

which is normally measured in Years.
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Field Details

Process destruction The boolean datatype is flagged if there is

any record to be destroyed. After that, the

record is marked in the Alfresco system

to be permanently destroyed so that all

information, metadata and physical traces

are removed and cannot be recovered.

After being created, the new File Plan will be displayed:

Procedure 4.21. Create a new Kofax

1. Follow the instructions in Add a new document: to open the Add New Kofax form and select

Add New Kofax from the drop-down list for the field Select Template.

The Add New Kofax form will appear:
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2. Input a name for a Kofax document in the Name field. This field is required. Some special

characters can not be used in the Name field(@ # % & * ( ) “ ' : ; [ ] { } / !).

3. Select categories for a Kofax document by clicking the

icon.

4. Click Save as Draft to accept creating a document or Cancel to quit the form.

After being created, a kofax document will be displayed like this illustration:

The File View tab is used to display all added nodes in that kofax. Besides, all added files in kofax

are also displayed in the Document View tab:

Procedure 4.22. Create new Event

1. Follow the instructions in Add a new document: to open the Add New Event form and select

Event from the drop-down list for the field Select Template.

The Add New Event window will appear:
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2. Enter a title for the event.

3. Input the location where the event will take place in Location field. Check the Google Maps

checkbox if you want the location of the event shown on Google Maps.

4. Enter the Start and End Date/time of the event.

5. Fill the Summary and Content fields.

6. Click Save to commit the event, or Cancel to quit without saving changes.

After being created, the event wll be displayed like the illustration bellow:

The event will be displayed in a website as:
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4.6.4.3. Add Folder

You can create a document immediately in a specific drive; however, adding a document into a

specific folder enables you to manage documents better.

There are two types of folder:

• Content folder.

• Document folder.
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In default skin, the icon for a content folder node is displayed in blue and the icon for a document

folder node is displayed in yellow.

File and folder types in a folder

Content folder

• You can add a Content Folder folder into a Content Folder one.

• You can add a Document Folder folder into a Content Folder one.

• You can add documents into a Content Folder.

• You can upload files (images, MS word documents, OpenOffice documents, .pdf files, .txt

files, .xml file, etc) into a Content Folder.

• You can import sub node(s) that was exported into a Content Folder.

Document folder

• You can add a new Document Folder into a Document Folder.
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• You can add File, Podcast, File Plan documents into a Document Folder.

• You can upload files (images, MS word documents, OpenOffice documents, .pdf files, .txt

files, .xml file, etc ) into a Document Folder.

• You cannot add a Content Folder into a Document Folder

• You cannot import an exported a Content Folder into a Document Folder.

• You cannot import an exported Article, Sample node, Kofax into a Document Folder.

Procedure 4.23. Create a folder

1. Select the path to create a folder.

2. Click

on the action bar. The Add a Folder form is displayed:

3. Click

to see the type list and select a folder type.

4. Input value for the Name field. This field is required. You can not input some special characters

in the Name field (@ # % & * ( ) " ' : ; [ ] {} / !)

5. Click Save to accept creating a new folder.

Folder Creation

A folder name can be the same as the existing one. When a new folder is created

with the same name with other existing folder, after you click Save, its name will

be added an index (e.g: test[2]).
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You can only create a content folder in another content folder.

You can create a document folder in a content folder or a document folder.

4.6.4.4. Add translations to a document

This function enables users to add multiple languages for a document. This action is similar to

adding a language.

By default, the Add translation button is not displayed on the action bar.

Enable this function by navigating to Administration > Content Presentation >Manage Views.

See Section 5.3.2.3, “Manage Views” to know how to add the Add translation button to the tabs

on the action bar in Content Explorer.

Procedure 4.24.

1. Select a document you want to add the translation for. For example; select an Article which

is in English:
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2. Click

on the Action bar. The Symlink Manager will appear:



Actions

81

3. Click

, then browse to the target document that has different language with the first document. For

example, the Article version in French.

4. After you have selected the document, click Save on the Symlink Manager form:

5. Select the document which you have added the translation to, then click the Relation button

on the sidebar.

You will see the available language for the selected document. Click the language on this

panel to view the document in the corresponding language version.
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4.6.4.5. Add symlink

You also easily add a sym link for a document for the purpose of fast accessing the document

that you are looking for:

To add a symlink do as follows:

Procedure 4.25.

1. Select a document that you want to add a sym link.

2. Click the

on the action bar. The Sym Link Manager pop-up will appear:
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Table 4.10.

Field Details

Path Node The path of a link

Symlink name The name of the link.

3. Click the

icon to open the Choose Target Node form.

4. Choose the workspace which contains the node that you want to add a symlink:

5. Click the

in the row of the node that you want to add, the path that the node will appear in the Path

Node field and the name of the node is set by the name of the selected node. You can also

edit this name.
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6. Click Save to add symlink.

4.6.4.6. Comment

This function is used to comment on a document (Note: you cannot comment for a File Plan

document).

Procedure 4.26.

1. Select a document that you want to add a comment to.

2. Click

on the action bar.

The Add Comment form appears:
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3. Add your comment in the Comment field.

4. Click Save.

Comments are shown at the bottom of the document:
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To view your comment click the Show Comments link:

You can edit your comment by clicking the

icon or delete it by clicking

.
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4.6.4.7. Edit documents

There are two ways to edit a document.

Procedure 4.27. Method One

1. Select a document you want to edit in the left panel.

2. Click

on the Action bar.

Or:

Procedure 4.28. Method Two

1. Select a folder that contains the document you want to edit.

2. Right-click the document you want to edit and select Edit from the menu.

The Edit Document form will appear. All information of the selected document will be

displayed in this form and ready for you to change except the Name field.

3. Click Save to commit the changes.

4.6.4.8. Export nodes

Nodes can be exported into either .xml or .zip file types.

Procedure 4.29.

1. Select a node that you want to export.

2. Click

on the Action bar to show the Export Node form:
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Table 4.11.

Fields Details

Path to Export The path of the node being exported. This

field will be prepopulated.

Format The format of the original node.

Document View Each node is a tag and properties of that

node are considered to be elements of that

tag.

System View Each node and each property of that node is

included in a different tag.

Zip If this field is checked, the node will be

exported as a .zip file.

3. Click Export and choose a location to save the exported file.

Exporting Versioned nodes

The Export Node form will offer an Export version history button if the node

being exported, or any of its child nodes, is versioned.

This action exports all of the node's version history.

4.6.4.9. Import Nodes

Nodes that are in the .xml file format can be imported in to the JCR Explorer system.

Procedure 4.30.

1. Select the location that you want to import the new node to.

2. Click

on the action bar . The Import Node form appears.
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3. Click Browse next to the Upload File field and navigate to the file you want to import.

4. Select the UUID from the drop down menu:

Create new

A new UUID will be created for the new node.

Remove existing

The new node will be created in the selected path with the UUID it was exported with.

Replace existing

The imported node will replace the existing node and UUID.

Throw Exception

This option will display an alert informing you if you can not import the file.

5. Click Browse next to the Version history to select a version to import.

6. Select a format.

7. Click Import to import the chosen version of the selected file.

4.6.4.10. Manage Actions

4.6.4.10.1. Add an action

Procedure 4.31.

1. Select the node you want to add an action to.

2. Click

on the action bar.
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The Manage Actions form will appear.

3. Select the Add Actions tab to open the form to add an action to the folder.

4. Click

and select the type of action from the drop-down menu.
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Table 4.12.

Field Details

exo:action This action is not supported.

exo:AddMetadataAction This action adds metadata

exo:autoVersioning This action automatically adds a version.

exo:createRSSFeedAction This action creates an RSS file.

exo:enableVersioning This action enables versioning.

exo:getMailAction This action fetches mail

exo:sendMailAction This action sends mail.

exo:taxonomy/Action This action creates categories

exo:transformBinaryTo TextAction This action converts .pdf or .doc file types to

plain text.

5. Complete the required fields in the form for the selected action.

Table 4.13.

ID The Id of action. This field is created

automatically and can not be modified.

Name The name of this action. This name is internal

to the JCR explorer.

Lifecycle Select the lifecycle for this action. The action

will be executed depending on the lifecycle:
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• 'Add': The action will be executed to a new

document, but not to a subfolder when the

document or the subfolder is created in the

folder in which an action has been added

to. It's also applied to a new document in

the subfolder of the folder.

• 'Modify': the action will be executed when

a folder /node is modified.

• 'User action': The action is executed

when right-clicking on the folder and then

selecting the action.

• 'Remove': The action will be executed to

a document, but not to a subfolder in the

folder when the document or the subfolder

is moved.

• 'Schedule': the action is done at specific

time. There are 2 schedule lifecyle

types: period and cron. (See more about

Schedule lifecycle).

If you need the same action to be executed

in several lifecycles, you have to create

several actions.

6. Click Save to commit the action.

All actions of a node are listed in the Available Actions tab.

Once an action is added to a node it is automatically added to any child nodes of the selected node.

If an action added with the lifecycle 'user action', it will be applied for the current node. And an

action added with other lifecyles, it will be applied for the child nodes.

Actions in menus

Not all actions are listed in a nodes right-click menu. Some will be performed

immediately when that action is added.



Actions

93

4.6.4.10.2. View Actions

Procedure 4.32.

1. Open the Manage Actions form and select the Available Actions tab.

2. Click

that corresponds to the action you want to view.

The details will be displayed in the Action info tab:

4.6.4.10.3. Edit an action

Procedure 4.33.

1. Open the Manage Actions form and select the Available Actions tab.
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2. Click the icon

that corresponds to the action you want to modify.

3. Edit the properties in the Actions form:

4. Click Save to commit the changes.

4.6.4.10.4. Delete an action

Procedure 4.34.

1. Open the Manage Actions form and select the Available Actions tab.
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2. Click the icon

that corresponds to the action you want to modify.

3. Click OK on the confirmation dialog box to delete the action or Cancel to quit.

4.6.4.11. Manage Auditing

This function logs property changes in nodes.

Procedure 4.35.

1. Select a node.

2. Click

on the action bar. The Activate Auditing message appears.

3. Click Activate to activate auditing on the selected node.
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4. Click

again to view audit information for the selected node.

The Auditing Information list appears.

If the node has no audit information the form will appear like this:

4.6.4.12. Manage Categories

4.6.4.12.1. Add a category for a node

You can add categories to document type nodes only:

Procedure 4.36.  Add a category

1. Select the node that you want to add a category to.

2. Click

on the action bar.

The Add category form appears.

3. Select the Select category tab to show the available categories.
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4. Click

to add the corresponding category to the node.

Categories that have been added to a node are listed in the Referenced categories tab of the

Add categories form.

All nodes belonging to a category can be viewed by doing the following:

Procedure 4.37.  View a category

1. Go to the drive that contains the category you have added. There will be a list of categories

available.

2. Select a category you want. The documents in that category will be listed.

Copy/paste nodes

When copying and pasting a node in a drive, a new node with the same content

will be created with a different name.

When copying and pasting a node in the category tree, a reference to the original

node will be created. This reference is a link rather than a copy. This feature

preserves disk space.
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4.6.4.12.2. Delete a Category

Procedure 4.38.  Delete a category

1. Select a categorized node.

2. Click the

icon.

3. Select the Referenced categories tab.

4. Click the

that corresponds to the category you want to delete.

4.6.4.13. Show/Hide Content

Nodes can be hidden or revealed as desired.

Procedure 4.39. Hide a Node

1. Select the node you want to hide.
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2. Click

on the Action bar to hide the node.

A message box will appear with a confirmation that the node has been hidden.

3. Show a Node

To reveal a hidden node, click

again.

4.6.4.14. Manage Publications

This function is used to manage node publication.

Procedure 4.40. Manage Publications

1. Select a node (on the left or right panel) which you want to manage the publication.

2. Click

on the actions bar.

The Manage Publications form appears:
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The Revision tab displays some basic information and the current state of the selected node.

3. Click

to view the content of the node or click

to restore a version (refer to Section 4.6.4.16, “Manage Versions” for information about

versioning)

4. Select the History tab to view the publication history of the node..
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5. Click Save to commit any changes made.

Important

See Section 4.3.3, “Publication Process” to understand more Manage

Publication

4.6.4.15. Manage Relations

You can use this function to create relationships between nodes

4.6.4.15.1. Add a relation

Procedure 4.41.  Add a relation

1. Select the node you want to add a relations to.

2. Click the

on the action bar.

The Add relation form appears.

3. Select the Select relation tab to see a list of other documents.
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4. Click the

that corresponds to the document(s) that relate to the document selected in the Step 1.

Documents linked to the original via a relation will be listed in the Relation List tab.

Relation Rules

• Relations can only be added to document and uploaded file node types

• A node cannot have a relation to itself.

4.6.4.15.2. Delete a relation

Procedure 4.42.  Delete a relation

1. Select a node that has links to related documents.

2. Click

on the action bar.

3. Select the Relation List to view the relations for the selected node.

4. Click

corresponding to the relation you want to remove.

5. Click OK on the confirmation message to delete the relation.

The related document will be removed from the list.

4.6.4.15.3. View Relations

Procedure 4.43. View Relations

1. Select a node that has links to related documents.

2. Click the relation button on the side panel:
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All nodes related to the selected node will be displayed in the left pane:
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3. Click the name of the related node to view the document.

4.6.4.16. Manage Versions

4.6.4.16.1. Add versions for nodes

Procedure 4.44.  Add version

1. Select a node to add a version to.

2. Click

on the action bar.

The following message box will appear:
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3. Click Activate to activate a version for the node.

4. Righ- click the selected node and select CheckIn from the right menu:
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5. Click

again to open the Version Info window.
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The node selected in step one has been added as the Base version.

6. Righ- click the node again and select Check out to obtain a version of this node.

Note

No actions (copy/cut/rename) can be taken on a node in Check In status. You

must check it out before you can perform any actions on it.

If you want to add more versions for a node, right- click the selected node above

and select Check In and then Check Out.

4.6.4.16.2. Add and Remov labels for Versions

Procedure 4.45. Add a label

1. Select a versioned node.

2. Click

on the action bar.

3. Click the

on the Version Info window to show the Add label field under the version list.
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4. Enter a value into the Label field.

The label must be unique and can not use special characters such as @, #, $.

5. Click Save to submit the new label.

Procedure 4.46. Remove a label

1. Select a versioned node that has at least one label.

2. Click

on the action bar.

3. Click the

on the Version Info window to show the Remove label field under the version list.

4. Select the label you want to remove from the drop down menu:

5. Click the Remove button to remove the selected label.

4.6.4.16.3. View versions

Procedure 4.47.

1. Select a versioned node.
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2. Click

.

3. Click

to see the current versions of the selected node.

Folder Nodes

Version viewing is not supported on folder nodes.

If you click

while the selected node is a folder, a message to this effect will appear.

4.6.4.16.4. Restore versions

Procedure 4.48.

1. Select a node that has at least two versions stored.
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2. Click

.

3. Select the version that you wish to restore as the base version.

4. Click

to restore the selected version

4.6.4.16.5. Delete versions

Procedure 4.49.

1. Select a node with at least two versions:

2. Click

.
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3. Click the

icon that corresponding to the version you want to delete.

A confirmation message will appear.

4. Click OK to delete the version or Cancel to quit.

Base Versions

You cannot delete a base version.

4.6.4.17. Multi Languages

This function is used to support users to add multiple languages for a document. Each document

can be displayed in many languages.

Procedure 4.50.

1. Select a document that you want to add language(s).

2. Click

on the Action bar.

The Multi-language form will appear.

The View language tab contains a list of all languages. The default language for the

document will be automatically populated.

3. Select the Add language tab. This tab will be displayed differently, depending on what file

you selected. However, the area where you can add languages for document is the same.

The below illustration shows the Add language tab for a Sample node file:
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4. Select a language you want to add from the Language drop-down list.

If the selected language has not been added for current document, the content field will be

blank.

Select the Set default checkbox if you want to set your selected language as default

language.

5. Click Save, you will be returned to the View languagetab. Your selected language is now

added to the Language field:

You can view this document in the new added language by selecting the language from the

language drop-down list then click the View  button.
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To view the languages list of a document, do the following:

Procedure 4.51. View the language list

1. Select a document that you want to view the language list, then click the Relation button

on side panel:

2. The list of language (and all related documents) will be displayed on the left panel:
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You can view the document in the new language by clicking the corresponding link in

Languages List.

For more details about Relations, refer to Section 4.6.4.15.3, “View Relations”.

Language Notes

You cannot add multiple languages for a File Plan.

When a document is a sub-node of File Plan, you also cannot add language to it.

4.6.4.18. Overload Thumbnails

You can 'overload' a thumbnail image for a folder. Overloading allows a folder to be represented

by a thumbnail image, rather than a folder icon.

To overload a thumbnail, do the following
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Procedure 4.52. Overload thumbnails

1. Select the folder you wish to overload with a thumbnail image.

2. Click

on the Action Bar.

The Add thumbnail image form appears:

3. Click Browse... button to select the image to use as the display icon for the selected folder.

4. Click Save to commit the change. The node will be sotred in an exo:thuumbnails folder.

4.6.4.19. Request Approval

When a content is created, if you want to publish it but you do not have the right to publish the

content, you must send an approval request for your content.

Do the following:

Procedure 4.53. Request Approval

1. Select a content that you want to send an approval request to publish.

2. Click the Request Approval button on the action bar.
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The content is displayed at the bottom of the Content Explorer of the people who have the

right to approve contents.

4.6.4.20. Approve Content

When a content is created by users, it maybe need approved to publish if there is a approval

request. To approve a content, do the following:

Procedure 4.54. Approve a content

1. Select a content that needs approving.

2. Click the Approve Content button on the action bar and the content is ready to be published.

Note

The Approve Content button is only invisible for users who have the right to

approve contents.

By default, the button is not displayed on the action bar.

Enable this function by navigating to Administration > Content Presentation

>Manage Views. See Section 5.3.2.3, “Manage Views” to know how to add

the Appove Content button to the tabs on the action bar in Content Explorer.

4.6.4.21. Publish Content

After the content is approved, it can be published by the people who have the permission to publish

contents.

Do the following:

Procedure 4.55.  Publish a content

1. Select a content that you want to publish.

2. Click the Publish Content button on the action bar. The content will be published as the

schedule that you set up.

Note

The Publish Content button is only invisible for users who have the right to

publish contents.
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By default, the button is not displayed on the action bar.

Enable this function by navigating to Administration > Content Presentation

>Manage Views. See Section 5.3.2.3, “Manage Views” to know how to add

the Publish Content button to the tabs on the action bar in Content Explorer.

4.6.4.22. Show Drives

This function enables you to show or hide all the drives in Content Explorer.

To show drives, click

on the action bar.

To hide drives, click

on the action bar again.

4.6.4.23. Show JCR Structure

This function allows you to view nodes in documents in a tree structure.

1. Show the JCR structure

Select a document.

2. Select the Info tab.

3. Click

.

4. Click the

icon to save the view.

The following information message will appear:
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5. Hide the JCR structure

Select a document that is showing the JCR structure.

6. Click

again.

4.6.4.24. Tag Documents

A tag is a (relevant) keyword or term associated with or assigned to a piece of information (a

picture, a geographic map, a blog entry, a video clip etc.), thus describing the item and enabling

keyword-based classification and search of information.

Procedure 4.56. Add a new tag for a document

1. Select a document that you want to add tags.

2. Click

on the Action bar. The Tag Manager will be displayed:
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Table 4.14.

Fields Details

Tag names The tag names that users want to add tags

for documents.

Tag Scopes To classify tags. There are four tag types:

private, public, group, site. Currently, the two

first types are activated(Private: a user who

create tags can view and edit tags; public: all

users can view and edit tags).

Linked tags To list all tags of a document after you click

the Add Tags button.

3. Input a value for the Tag names field. A document can be added several tags at a time. To

do that, input all tag names in the Tag names field and separate by “,”.

4. Select a value for the Tag Scopes field.

5. Click Add Tags to accept, or Close to quit. Only you can see this tag in this document.

6. Click the

to delete tags.

Procedure 4.57. Remove tags from a document

1. Select a document with tags that you want to delete the tags.

2. Click

on the action bar to open the Tag Manager form.
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3. Click

corresponding to the tags you want to deletes.

4. Click OK on the confirmation message to delete the tags.

4.6.4.25. Upload files into folders

This function supports you to upload a file from your machine. All file types can be uploaded. The

uploaded file's name must not include some special characters (! @ $ % & + [ ])

Procedure 4.58. To upload file into folder, do as follows:

1. Select the folder that you want to upload a file into from the left/right panel

2. Select the Actions tab to show some actions on the Action bar.

3. Click

on the Action bar to open the Upload a file form:

4. Browse and select a file on your computer by clicking the Browse... button. The selected

filename will be displayed in the Select a file field.

If you want to upload multi files at the same time, click

to open more forms to upload more files:



Actions

121

The

enables users to delete the upload file form.

5. You can change the uploaded file by clicking the

icon and select Browse... again to select another one.

6. By default, the name of the uploaded file will be kept as original but if you want to change,

you can type the new name in the Name field, this field is not required. The new name must

not contain special characters: ! @ $ % & + [ ].

7. You can click the

icon next to the List Taxonomy field to add categories for this file:
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8. Select categories by clicking the

icon. Click '+ ' to open child nodes of categories.

Note

You can add more categories for a file by clicking the

icon again to open the Add Categories form.

Click the

icon to delete a category in Upload a file form.

You also manage categories which were added to files by using the Manage

Categories function. See Section 4.6.4.12, “Manage Categories”.

9. Complete uploading file by clicking Save.
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10. After being saved, the main information of the uploaded file will be displayed:

11. Click the

icon to see more details of its external metadata information. The  List external metadata

tab will be enable and you can input value in this tab.

12. Click Save to accept changes or Cancel to quit without any changes.

13. Data can be added for the uploaded file. Check the checkbox, then click Add, or Cancel to

quit without adding anything.
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14. New metadata is displayed in External Metadatas list and you also can edit it by clicking

.

15. Click Close to quit the Uploaded information form.

16. After being uploaded, the tree is displayed in the left panel:
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File Size Limits

The size of the uploaded file depends on the size limit of the uploaded file that

you set up in the 'Edit' mode of Content Explorer. If your file size exceeds the

limit, a pop-up message will appears to alert you.

4.6.4.26. View Metadata

This function allows you to view the metadata attached to File nodes, Podcast nodes, File Plan

child nodes and uploaded file nodes (nt:file nodes)

Procedure 4.59.

1. Select an appropriate (nt:file) node.
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2. Click

. The View Metadata form appears:

3. Click the Add/Edit button at the bottom of the View Metadata form to add metadata.

4. Complete the desired fields in the Add/Edit Properties form. Click

to add further metadata.
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5. Click Save to commit the new metadata values.

4.6.4.27. View Node Types

To view detailed information about a node:

Procedure 4.60.

1. Select a node that you want to its detailed inforamtion.

2. Click

to view detailed information about the selected node.
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3. Click the tabs at the top of the form to view categorized information.

4.6.4.28. View Permissions

This function enables an administrator to manage the permissions for nodes.

Procedure 4.61. View Permissions

1. Select a node.

2. Click

. The Permissions Management form appears.



Actions

129

With the Permissions Management form open you can perform the following actions:

Procedure 4.62. Add Permissions

1. To add permission for specific users

Click the

button next to the User Or Group field.

Click the

beside the users you want to grant permissions to.

2. To select users from a specific group

Enter a group name in the Group field at the top of the form (for example; /platform/users).

All users in the nominated group will be displayed.

Or;

Click the
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icon beside the Group field to open a form that lists groups and their sub-groups. Select a

sub-group to add all users in that sub-group.

3. To search for a user

Select an information parameter (User Name, First Name, Last Name,

Email) from the drop down menu in the other field at the top

of the page and enter the information into the text box. Click

to search for users that match that information.

4. To add permissions based on memberships

Click the

icon next to the User Or Group field.

The Select membership form that appears allows you to select users by membership. Select

a group on the left pane and then select membership types on the right.

5. To add all users/groups with read access

Click the

icon next to the User Or Group field.

6. Select the permission you want to grant the chosen users or groups by ticking the

corresponding check boxes beside the rights you want to add.
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7. Click Save to commit the changes. The new permissions will appear in the permissions table

above.

Procedure 4.63. Edit Permissions

1. Select the permission of a user or a group in the table of list permissions.

2. Click the

icon.

3. Change the permissions as desired.

4. Click Save to commit the changed permissions.

Procedure 4.64. Delete Permissions

1. Select the permission of a user or a group in the table of list permissions.

2. Click the

icon.

3. Click OK in the confirmation message to remove the permission or Cancel to quit.

4.6.4.29. View Properties

This function allows users to review all the properties and values of a node. It can also be used

to add values to a node.

Procedure 4.65.

1. Select the node that you want to review or add values to.

2. Click the

button to show the Properties Management form:

This form has two tabs:

Properties

This tab displays all properties and values for the selected node.
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Select this tab to review the properties for the selected node without making any changes.

Add New Property

This tab contains fields to add new properties to the selected node.

Select this node if you want to make changes to the properties of the selected node.

3. To add new properties:

Select the namespace for the property.
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4. Enter a name for the new property in the Name field.

5. Select a Type for the property from the drop-down menu for the field Type.

6. Enter a value for the property in the Value.

7. To add multiple new values, click

and repeat the above steps.

To remove a value, click

.

8. Click Save to commit the new values or Reset to clear any modified fields.

After you commit new properties, you will be returned to the Properties tab. The newly added

values will be displayed.

In this form you can edit a property by clicking

or delete it by clicking
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4.6.4.30. View Relations

This function shows documents related to a selected node.

1. To View Relations

Select a node > Click

. Documents related to the selected node will be shown in the sidebar.

If the node does not have any related documents the message No related document will

appear instead.

2. To Hide Relations

Click

again to hide relations.
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4.6.4.31. Vote

This function is used to vote for a document (Note: you cannot vote for a File Plan document).

Procedure 4.66.

1. Open the document you want to vote for.

2. Click

.

The Vote Document form will appear:

3. Rate the document by clicking on the appropriate star level for your vote:
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After a vote has been added, the rating will appear at the bottom of the document:

4.6.4.32. Watch Documents

By using this function, whenever a change is made on the document, there will be a notification

message sent to your email address. To receive that email, you must configure in your mail server.

Procedure 4.67.

1. Select the document you want to watch.

2. The Watching Document form will appear. Click the Watch button to finish.

To stop watching a document, select the document and click

.

A message will appear for you to confirm the action.



Manage Content In Content Explorer

137

4.6.5. Manage Content In Content Explorer

A web content is a key resource to make a site. Other resources make a site more dynamic and

animated by using layout, color, font, and more.This section focuses on how to manage a web

content in a specific site.

Note

Only users who have the right to access Sites Management drive can do it.

4.6.5.1. Create a new web content

This function is used to add a new web content into a specific site.

Do the following steps:

Procedure 4.68. Add new content

1. Go to Sites Management drive > select a site that you want to add a web content.

2. Select the web content folder on the left:

Note

In this step, you also can add a new web content into another folders

(documents and media folder) of a site but you are recommended to select

the web content folder because:

• Manage web content of a site more easily.

• You only may add a new web content in this folder so that you don't need

to select a web content document in the list of document types. It makes

adding a new web content more flexibly.
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3. Open the Add New Document form by clicking

on the Action bar.

4. Select a template in the Select Template field to present web content:

The Select Template field has two options:

• Picture on head layout web content:The site's content is presented in two spaces. One

for inserting an image and one for editing the site's content. In which, the image is put at

the head of a site.

• Free layout web content:This template is a free layout.

5. Enter values in fields of the Add New Document form.

6. Click Save as Draft to save the content or Cancel to quit the Add New Document form.

7. Tabs in the Add New Document form. 

The Main ContentTab includes:

Table 4.15.

Field Options

Name The name of a web content that you want to

add new
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Field Options

Title The title of a web content

Main content The main content that you want to display

when publishing this web content

Save button To accept saving the inputted values

Cancel button To exit the current form

The Illustration Tab: enables you to upload an illustration that makes the site's content more

attractive

Table 4.16.

Field Option

Illustration Image The path to an image that you want to upload

into a site. This image will be used like an

illustration of that site

Image Type The image format that you want to upload

to the site. It can be: image/gif; image/png;

image/jpg; image/jpeg

Summary You can give short description about the web

content because it will be displayed with the

illustration image when the web content is
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Field Option

listed. The main content will be shown when

it is selected to be viewed

To upload an image do as follows:

Procedure 4.69.  Upload an image

1. Browse an image list on your local computer by clicking the Browse... button and then

select a specific location.

2. Select an image in the list to upload.

The Advanced tab:

This tab includes two parts: CSS data and JS data:

Table 4.17.

Field Information

CSS data Contains CSS definition to present data in a

web content. You can optionally enter CSS

data into this field to specify the style.



Manage Content In Content Explorer

141

Field Information

JS data Contains JS content to make the web

content more dynamic when after publishing.

You can optionally enter JS content in this

field.

4.6.5.2. Edit a web content

This function is used to edit a web content in a specific drive of an existing site.

Do the following:

Procedure 4.70. Edit a web content

1. Go into the folder of a site which contains the web content that you want to edit.

2. Select to view a web content by double-clicking it on the left tree or on the right. The detailed

information of web content will be viewed on the right panel.

3. Click

the action bar to show the edit form of the selected web content as the Add New Documetn

form.

4. Change the current values in the fields of this edit form.

5. Complete editing the selected web content by clicking Save.

Auto-lock

When you click Edit Document, the web-content will be auto-locked for your

editing. After finishing, the content is back to unlock status. You can manage Locks

in the Administration portlet.

4.6.5.3. Delete a web content

This function is used to remove a web content from the web content folder in a specific site's drive.

To delete a web-content, do the following:

Procedure 4.71. Delete a web content

1. Right-click the name of the web content that you want to delete and then select Delete in

the menu:
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2. There will be a confirmation message. Click OK to accept the deletion, or Cancel to quit

without deleting.

4.6.5.4. Publish a web content

This function helps you publish a web content that you have added to web content folder in Content

Explorer.

See Section 4.3.3, “Publication Process” to know how to publish a web content.

After the content is published, all users who have the right to access that position can view the

published web content as a page on the Navigation bar.

4.6.6. Actions on Folders and Documents

In this section, we will present the actions on folders and document in the right-click menu (Add

to favorites, copy, cut, paste, add Symlink, lock/unlock, view document, rename, download and

allow edition and copy URL to clipboard) and other actions (drag and drop folders or documents).
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Depend on the actions on folders or documents, the right-click menu (drop-down menu) is

different.

The actions in the right-click menu for documents:
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The actions in the right-click menu for folders:
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4.6.6.1. Add to favorites

This function helps users easily add nodes (documents, folders or files) as favorite.

Procedure 4.72.

1. Right-click a node you want to add as a favorite

2. Click
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A symlink of your favorite nodes (folders, documents, files) will be created in the Favorite folder.

4.6.6.2. Copy/Paste

This function is used to make a copy of a node (including sub-nodes) to other places.

There are two ways to cut/copy/paste the node:

Procedure 4.73. Method One

1. Right-click the node > select Copy from the drop-down menu (or called "the right-click menu").

2. Select a destination node that you want to be the parent node of the cut/copied node.

3. Right-click the destination node > select Paste in the dorp-down menu. Note that the Paste

function is enabled in the menu only after selecting the Copy action.

4. The copied folder (and its sub-folders) will be pasted to the new selected path.

Procedure 4.74. Method Two

1. Right-click the node and select the Copy from the drop-down menu.

2. Select the destination node that you want to be the parent node of the copied node.

3. Select the Clipboard icon on the sidebar:



Actions on Folders and Documents

147

4. Click the Clipboard window will appear:



Chapter 4. Basic Actions

148

5. Click the

in the clipboard window to paste the copied node into the selected destination node in step 3.

6. You can click the

to delete a specific waiting statement.

7. You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information

about the destination path.

Copy/Paste Information

• You only can take the Copy action if you have a right on the source node.

• You only can take the Paste action if you have a right on the destination node.

• If the destination node has the same name with the copied node, after being

pasted, the pasted node will be added an index with its name. For example, in
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this case, if “new folder” contains a node with name “Live”, then after the paste

action, in “new folder” there are two nodes with name Live and Live[2].

• You cannot copy a content folder into a document folder.

• After taking the Copy action, you can take the Paste action on different nodes

before taking another Copy action.

4.6.6.3. Edit documents

To edit a document, refer to this part Section 4.6.5.2, “Edit a web content”.

4.6.6.4. Cut/Paste

This function is used to move a node (include sub nodes) to other places. There are two ways

to cut/paste documents:

Procedure 4.75. Method One

1. Right-click a node > Select Cut from the drop-down menu.

2. Select the destination node that you want to be the parent node of the cut node.

3. Right-click the destination node > select Paste in the drop-down menu. Note that the Paste

function is enabled in the menu only after selecting the Cut action.

4. The cut node (and its sub-nodes) will be pasted to the new selected path.

Procedure 4.76. Method Two

1. Right-click a node > Select Cut from the drop-down menu.

2. Select the destination node that you want to be the parent node of the cut node.

3. Select the Clipboard icon:
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4. Click the Clipboard window will appear:
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5. Click the

in the clipboard window to paste the copied node into the selected destination node in step 3.

6. You can click the

to delete a specific waiting statement.

7. You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information

about the destination path.

Cut/Copy/Paste Information

• You only can take the Cut action if you have a right on the source node.

• You only can take the Paste action if you have a right on the destination node.

• If the destination node has the same name with the cut/copied node, after being

pasted, the pasted node will be added an index with its name. For example, in
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this case, if “new folder” contains a node with name “Live”, then after the paste

action, in “new folder” there are two nodes with name Live and Live[2].

• You cannot Cut a content folder into a document folder.

• After taking the Cut action, you can take the Paste action on different nodes

before taking another Cut action.

4.6.6.5. Delete folders and documents

This function helps you remove folders/documents from theirs location easily. Do the same steps

as Section 4.6.5.3, “Delete a web content”

Delete Rights

• You can only take the Delete action if you have the right on a node.

• If the deleted node also contains sub-nodes, these will be deleted also.

4.6.6.6. Drag and drop folders and documents

This function allows you to move folders/documents from a current location to another one by

using the drag and drop feature.

Procedure 4.77.

1. Move the cursor on a folder/document or folders/documents on the right panel (hold the

Ctrl or Shift key to select multiple folders/documents at once) until the cursor changes to

.
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2. Press the left mouse button and then drag the selected folder(s)/document(s) to another folder

on either the right or left panes.

3. Drop them into the selected folder (by releasing the left mouse button). All 'dragged' folders/

documents will be relocated to the destination folder.

4.6.6.7. Lock/Unlock folders and Documents

This function enables you to avoid changes to specific folders/documents, actioned by others,

during a specific time.

Lock folders/documents.  Just right-click a folder/document (on either the right or left window

pane) and select Lock from the menu. The selected folder/document will be locked.
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Locking Rights

• Only users with appropriate rights can lock folders/documents.

• After locking, other users can only view the folders/documents.

• The lock will be kept current for a session only. if the locking user signs out, the

node will be unlocked

• Other users can create a copy of the locked node (by using the Copy/Paste

functions outlined above), however the original node cannot be removed or

altered.

• If no action is taken on a locked node within 30 minutes, the lock will be

automatically removed.

Unlock folders/documents.  To unlock a folder/document, right-click a locked folder/document

and select the Unlock item on the menu. The folder/document will then be unlocked and other

users can take actions on it.

4.6.6.8. Rename folders and Documents

This function is used to change the name of a folder/documents.

Procedure 4.78.

1. Right-click a folder/document that you want to rename then select Rename from the menu:
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The rename form will appear:
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2. Input a new name in the Name field. You can also change the title of this folder by entering

a new one in the Title field.

3. Click Save to commit the new details.

4.6.6.9. Add a symlink

For the purpose of fast accessing the node that you want to look for in other nodes, adding a sym

link for a node is an effective way to meet this need.

Procedure 4.79.

1. Select a document that you want to add a symlink.

2. Righ-click that document and select Add SymLink from the menu.

3. The selected document will be added a symlink immediately. You now can click the sym link

to view its content.

4.6.6.10. View WebDAV

WebDAV enables people to access files, folders and read and write documents over the web.

Due to its benefits of easy, quick and flexible manipulations and time saving, WebDAV is used

to view nodes.

Procedure 4.80.

1. Select the path of node you want to view webDAV or open that folder from the left/right panel.

2. Right-click the node and select the Download and Allow Edition item in the menu.

3. With each type of node, form to view in WebDAV will be different:

• Folder: The sub-nodes list of the current folder will be displayed in WebDAV.

• nt:file: The content of the document will be shown.
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• Article: This node type does not, by default, list any folders. However, if the Article includes

actions, added language or other data, all folders will be listed and named; exo:actions,

exo:language and so on.

• Podcast: Veiwed in WebDAV, this node type will be attached a form that users have to

complete to download this document.

• Sample node: This node lists folder names as exo:images. Like Article, if the Sample node

contains actions or added languages, folders will be named exo:actions, exo:language and

so on.

• File Plan: This node behaves the same way as Article and Sample node.

• Kofax: This node behaves the same way as Article and Sample node

4.6.6.11. View Document

The View Document item is visible in the drop-menu when you right-click on a document. This

function enables you to view the document on another browser with the link containing the

document path.

Do the following to view a document.

Procedure 4.81. View a document

• Right-click a document that you want to view > Select View Document in the drop menu.

The document is opened in another browser:
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The URL of the document is like the following:

URL: ...ecmdemo/private/acme/siteExplorer/repository/Private/User guide

4.6.6.12. Copy URL to Clipboard

The Copy URL to Clipboard enables you to copy the Webdav URL of a selected folder or a

document and then you can view it by WebDAW view on a browser.

Do the following:

Procedure 4.82. Copy URL to Clipboard

1. Right-click a folder/document > Select Copy URL to Clipboard.

2. Paste the URL on another browser.
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You can view the folders of the node you copied its URL or download documents to your

computer. You also view other nodes by clicking ... above the current folder to go up the root

node . See the below illustration:

4.6.6.13. Manage Tags

Tags are easily managed by editing or deleting them with the Tag Manager.

Procedure 4.83. Edit a tag

1. Click the

icon at the upper-right corner of the tags panel.

The Edit tag form will appear:
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2. Click the

that corresponds to the tag you want to edit.

3. Edit the tag as desired.

4. Click Save button to commit the change or Cancel to quit without changes.

Procedure 4.84. Delete a tag

1. Perform Step 1 from the procedure above.

2. Click the

A confirmation box will appear:

Click OK button to delete the tag or Cancel to quit.
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Procedure 4.85. Use Created tags

1. Select the Tag cloud

you will see all existing tags. All existing tags are listed and classified by private or public tags.

Depending on the popularity of tag, the displaying of each tag will be different from others by:

font-size, font-weight, color, font-family, text-decoration. For example, when a tag is added

for over 10 documents, it will be displayed in red color, size:20px, bold. This is also can be

configured in the Administration portlet.

2. Each tag is also like a link used list all documents that it is added. Click a tag name, documents

list will be displayed in the right panel.

4.7. Manage Site Content with WebDAV

4.7.1. What is WebDAV

WebDAV is an abbreviation of Web-based Distributed Authoring and Versioning.. It is used to

publish to publish and manage file and directories on a remote server. It also groups users to

perform these these functions on a website.

WebDAV provides the following features:
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Locking

This feature prevents two or more collaborators from overwriting shared files.

Site Manipulation

WebDAV supports copy and move actions and the creation of collections (file system

directories)

Name space management

This function enables copying and moving web pages within a server's namespace.

4.7.2. Why use WebDAV?

You should use WebDAV to manage site content because of the following reasons:

• Copy/paste web content on a desktop machine and have those changes reflected in a host-

based website.

• Easily, quickly and flexibly manipulate actions on a website without having to access it directly

with web-browsers. FIles can be accessed from anywhere and are stored as in local directories.

• Easily and quickly upload content to a website simply by copying it into the appropriate directory.

4.7.3. How to Use WebDAV With eXo Content

eXo Content supports WebDAV in two ways:

This way is used when you are on a Window System and your computer has to be connected

to the Internet or Intranet.

Procedure 4.86. Method One:

1. Navigate to the My Network Places on your local computer. You will see all shared files

and folders:
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2. Click the Add a network place link on the left to open the Add Network Place Wizard:

3. Click Next to choose a network location:
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4. Select Choose andother network location to create a shortcut.

5. Enter an address into the Internet or network address field. As an example, the address

of the demonstration site Acme is  http://localhost:8080/portal/rest/private/jcr/repository/

collaboration/sites/content/live/acme

6. Click Next. After a few moments a folder named acme on localhost will appear in the My

Network Places directory.
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Each site being managed by WebDAV will appear as a folder in this location.

7. Take action on the content in this folder to administer the site content remotely.

Procedure 4.87. Method Two:

1. Navigate to http://localhost:8080/portal in your web browser.

2. Click Group > Content Explorer in the administration bar.

3. Click the Drives button > select Sites Management.

http://localhost:8080/portal
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You will see all sites listed in the left sidebar:
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4. Right-click the site you want to view with WebDAV and select the Download and Allow

Edition item in the menu.
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The selected site will be shown in WebDAV:

In this view you can you can access documents in the directories that are linked to the web

server.

4.7.4. Actions

You see all default folders of a site when accessing it via WebDAV. Manipulating content through

WebDAV is the same as working on it in local folders.

This means you can copy/paste files, list folders, rename and more in system directories.
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4.7.4.1. Add new content to a specific site

This function allows you to copy web content (such as an .html file) from your local computer to

a web content folder of a site.

Procedure 4.88.

1. Access a site via WebDAV (refer to Section 4.7.3, “How to Use WebDAV With eXo Content”),

then go to a web content folder of the site.

2. Copy the web content on your local system into this folder.

The copied file will be converted to web content that is viewable by WebDAV automatically.

The content is converted to a directory containing CSS, documents, js and media.

After new content is added it can be viewed as a folder in WebDAV or as page content using a

web browser.

4.7.4.2. Delete a web content

This function enables site administrators to delete web content files singularly or in batches.

Procedure 4.89.

1. Navigate to the folder that contains the content you want to remove.

2. Right-click the content files or directories (hold the Ctrl key to select multiple files at once)

and select Delete from the context menu.
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The selected file(s) will be removed from the site.

4.8. Search in Content Explorer

There are three ways to search an existing node:

1. Section 4.8.1, “Simple Search”.

2. Section 4.8.2, “Advanced Search”.

3. Section 4.8.3, “Quick Search”

4.8.1. Simple Search

This function is used to search with properties of the document (Note: Not the document's name).

Procedure 4.90.

1. Enter a string that is found in the document you are searching for (Note: Do not use the

document's name).
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2. Click the

icon to perform the search.

Search results will be displayed in the right pane.

The search results will appear empty if no node contains the search string.

3. Click the

to view the content containing the search string.

Or click the

icon to go to the node that contains the search result.

4.8.2. Advanced Search

To perform an advanced search:

Procedure 4.91.

1. Click the

Saved Search icon.
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2. Then click the Advanced Search icon

to open the Advanced Search form.

The Advanced Search form will open:
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The tabs in this form offer different search functions:

• Section 4.8.2.1, “Search by Name”

• Section 4.8.2.2, “Search with constraints”

• Section 4.8.2.3, “Search by creating a new query”

• Section 4.8.2.4, “Search by existing queries”

4.8.2.1. Search by Name

Use the Search by Name tab to search nodes by name:

Procedure 4.92.

1. Enter the exact name you wish to search for in the Content name field.

2. Click Search.

Results will return with the message “No result found” if there is no node with the entered

name.

Results will be returned in the Search Results tab if the requested name is found.

4.8.2.2. Search with constraints

This search allows you to search with more constraints to limit the returned results.

Extra search constraints are entered in the Advanced Search tab of the Advanced Search form.
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The Current location field is not editable. It shows the path selected to search.

Procedure 4.93.

1. Enter search terms in the A word of phrase in content field.

2. Select the Operator.

• Select AND operator to only return results that meet both the search terms and the entered

constraints (see Step 3).

• Select OR operator to return results that meet either the search terms or the entered

constraints (see Step 3).

3. Click  Show/hide constraints form to add more constraints.

A further constraint options window will appear:

Table 4.18.

Item Details

1 You can add more than one constraint thus

there are two operators AND and OR for you

to combine them.

2 These fields allow you to add a constraint to

search by a property with specific values.

3 These fields allow you to add a constraint to

search by a property with specific values.
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Item Details

4 These fields allow you to add a constraint to

search by a property that contains one of the

word in the specific string.

5 These fields allow you to add a constraint to

search by a property that does not contain

the specific string.

6 These fields allow you to add a constraint

to search by a duration of date (created,

modified).

7 This field allow you to add a constraint to

search by the document type (File, Article,

Podcast, Sample node, File Plan, Kofax).

8 This field allow you to add a constraint to

search by categories.

Add a document type.

Add a category.

4. Select the constraint operator(AND/OR).

5. Add the required constraints using one of the follow methods:

1. Add a constraint for exact values

2. Add a constraint including or excluding values

3. Add a constraint by date

4. Add a constraint by document type

5. Add a constraint by category

Procedure 4.94. Add a constraint for exact values

1. Check the box that corresponds to the constraint you want.

2. Enter the property you want to locate or click the Add property icon

.
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A list of possible properties appears:
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3. Select a property from the list and click Add. The selected property will populate Property

field.

4. Define the property value to search for by entering a value

into the Contain exactly field or click the Find exactly icon:

The Filter form will appear:

All pre-existing values for the property you selected will appear.
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• If the value you require is in the list, select it and click Select.

• If the value you require is not in the list, enter it in the Filter: field and click

icon. The value will populate the Contain exactly field of the constraints form.

Procedure 4.95. Add a constraint including or excluding values

1. Check the box corresponding to the Contain or Not Contain constraint, as appropriate.

2. Enter the required property in the Property field or click the Add Property icon

(refer to Step B in Add a constraint for exact values for more information).

3. Enter the required values in the Contain or Not Contain fields.

Procedure 4.96. Add a constraint by date

1. Click the check box beside the field with the drop-down menu (below the Property

entries).

2. Define the search condition from the drop down list (CREATED/MODIFIED).

3. Click in the From field.
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A small calendar will appear;

Select the date you want to use as a contraint.

4. Repeat the above steps for the To field.

The selected dates will populate the From and To fields in the Add constraint form.

Procedure 4.97. Add a constraint by document type

1. Click the check box beside the Document Type field.

2. Enter the document type you want to search for or click the

icon for a list of document types:
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3. Click the check box of the document type you want and click Save.

The selected document type will populate the Document Type field.
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Procedure 4.98. Add a constraint by category

1. Click the check box beside the Category field.

2. Enter the category you want to search for or click the

icon for a list of categories:

3. Click the

that corresponds to the category you want.

The selected category will populate the Category field.
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6. Click Add to add any/all activated constraints.

The constraints will be converted to an SQL query and displayed in the search form:

Remove unnecessary constraints with the

icon.

7. Click Search to launch the search. Results will be displayed in the Search Results tab.

8. Click Save and give this search configuration a name if you want to save it for use at another

time.

4.8.2.3. Search by creating a new query

You need a knowledge of the structure of query statements in order to configure a search using

the parameters on the New Query tab
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Procedure 4.99.

1. Enter a unique name for this query in the Name field.

2. Choose a query type from the drop down menu; SQL or xPath

3. Enter a query statement.

4. Click Search to perform the search and display the results in the Search Results tab.

Or click Save to save the search query to the Saved Query tab.

Or click Cancel to quit.

4.8.2.4. Search by existing queries

This tab lists all saved search queries (that you have access rights to use).

• Click

to perfom the search and see the results in the Search Results tab.

• Click



Chapter 4. Basic Actions

184

to edit the query statement. The query form will appear as it does when creating a query (see

Section 4.8.2.3, “Search by creating a new query”) however you cannot edit the name of the

saved search.

• Click

to delete a query (provided you have access rights over that query).

4.8.3. Quick Search

To perform a quick search:

Procedure 4.100.

1. Click the

icon to see the list of existing queries.
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A query list will appear. It contains the sections; All Articles, Created Documents,

CreatedDocumentDayBefore and allArticles.

2. Launch, modify or delete the queries as required (see Section 4.8.2.3, “Search by creating

a new query” for more information).

3. Filter results with the entries in the All Items and/or By Type panes on the left of the tab.

Items matching the selections will appear in the right pane.

4. Click the required document or folder name to view and or download them.

4.9. Preferences

This function is used to set up your browsing preferences.

Procedure 4.101.

1. Click on

on the right side of the Content Explorer portlet.

The Preference Setting window will appear:
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Table 4.19.

Setting Details

Sort by This condition is used to sort nodes in nodes

list.

Show sidebar This option is to display a sidebar.

Enable drag and drop This option is to allows taking the “drag and

drop” action or not.

Nodes per page This number of nodes that will be displayed

per page.

Show non document nodes This option is to display nodes that are non–

documents.

Show referenced documents This option is to display referenced

documents.

Show hidden nodes The option is to display hidden nodes.

Query Type This query type.

Enable DMS structure. This option is to display nodes in a document

in tree structure.

2. Configure the preferences as required and click Save to set them.

Or click Back to quit without submitting changes.

4.10. Newsletters

eXo Content provides a newsletter service aiming at helping users quickly get the updated

newsletters from a website.
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4.10.1. Newsletter Viewer

Users instantly get newsletters from your email in order to update the newest information about

categories and subscriptions that users frequently care about.

Do the following to subscribe to newsletters from eXo Service:

1. Go to Newsletters on the navigation bar. The Newsletters page will appear:

2. Enter your email address in the Your Email field.

3. Select the check box corresponding to the subscription that you want to get newsletters.
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4. Click Subscribe. A message informing that you have just subscribed to the selected

newsletter will appear.

5. Click OK in the confirmation message. You can reselect the subscription that you want or

do not want to receive newsletters by re-selecting the check box in the Check to subscribe

column.
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6. Click Change your subscriptions to update your changes.

7. Click Forget this email if you want to unsubscribe from newsletters.

4.10.2. Manage Newsletters

eXo Content facilitates administrators to easily and quickly manage and control newsletters. Go

to Group > Newsletters on the administration bar to access Newsletters.

4.10.2.1. Category Management

This section details category management.

4.10.2.1.1. Add a new category

Procedure 4.102. Add a new category

1. Click New Category on the action bar of the Newsletters page. The Category form will appear.
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Table 4.20. Category Form Field Details

Field Description

Name The name of a category. This field is

required.

Title The title of a category. This field is required.

Description A brief description of the category.

Moderator Allows an administrator to select which

memberships what group can manage this

category.

Save Accepts the addition of a new category.

Cancel Quits the category form without adding a

category.

2. Input values for fields

Select a moderator for a category by clicking

next to the Moderator field to select a user. The User selector form will appear.
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3. Click

to select a user in the list.

4. Click

to select users in a specific group. The Group selector will appear.

Select a group from the left panel and a membership type in the right panel. The membership

and group selected will be displayed in the Moderator field. After adding new categories, they

will be added in the list of categories.

5. Click the category that you want to manage, for example, the Fashion category.
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Here you can create new subscriptions or newsletters for this category.

6. Click the Administration button to open the menu that lists all actions that an administrator

can take on this category.

4.10.2.1.2. Edit a category

1. Select a category that you want to edit > Click Administration > Edit Category to bring up

the Category form.

Table 4.21. Category Form Field Details

Field Description

Name The name of this category. This field cannot

be changed.

Title The title of the category. This field can be

changed.

Description A brief description of the category. This field

can be changed.

Moderator Allows an administrator to select which

memberships in what group can manage
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Field Description

this category by selecting membership and

group. This field cannot be changed.

Save Accepts the changes made to the category.

Cancel Quits the category form without saving

changes.

2. Change the values in the Title and Description fields as required.

3. Click Save to save all changes, or Cancel to quit without saving any change.

4.10.2.1.3. Delete a category

Procedure 4.103. Delete a category

1. Click Delete category in the menu. A confirmation will appear:

2. Click OK to delete the category or Cancel to exit without deleting.

4.10.2.1.4. Manage Users

Administrators can manage users accounts and activity with edit, ban, remove ban or delete

actions.

Procedure 4.104.

1. Click Administration > Manage Users in the menu. The Manage Users form will appear:
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Table 4.22.

Field Details

Email The email address of user who has

subscribed this subscription.

Banned This field has two values:

False

The user is allowed to get email.

True

The user isn't allowed to get email.

To edit this user.

To ban this user from receiving email.

To remove a ban on a user.

To delete the user.

2. Click Close to close the form.
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4.10.2.2. Subscriptions

An administrator can add more subscriptions to any category. There are two ways to do this:

Procedure 4.105. Method One

1. Click New Subscriptions on the Action bar.

The Subscription form will appear:

Table 4.23.

Field Details

Category The category that contains this subscription.

Name The name of the subscription. This field is

required.

Title The title of the subscription. This field is

required.

Description The brief description about the subscription.

This field is not required.

Redactor Allows an administrator to select which

memberships in what group can manage this

subscription by selecting membership and

group. This field cannot be changed.
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2. Click

and select the category from the drop-down menu.

3. Enter the rest of their values in the form.

4. Click Save to create the new subscription or Cancel to quit without creating a new

subscription.

Procedure 4.106. Method Two

1. Click directly on the category that you want to create a new subscription to:

2. Click New Subscriptions on the Action bar.

The Subscription form will appear:
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Administrators can create newsletters for each subscriptions.

These Newsletters can be opened, edited, deleted or converted to a template for reuse.

Table 4.24.

Element Details

Shoes The name of the subscription.

Fashion Shoes The brief description about the subscription.

Letter The list of all letters of this subscription.

Date The date and time when creating this letter.

Status There are three types of status: draft, awaiting

and sent.

Moderation This button allows you to take actions on a

newsletter that you select.

4.10.2.3. Open a Newsletter

Administrators can easily view the content of a newsletter.

Procedure 4.107.

1. Choose a category by left-clicking it or checking the box and then selecting Administration

> Open.

2. Select the newsletter that you want to open by left-clicking it, or selecting the checkbox.
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3. Click the

button, then select Open in the menu:

The View Newsletter's Content form will appear:



Manage Newsletters

199

4. Click Close to exit.

4.10.2.4. Edit a newsletter

Do the following to edit a newsletter.

Procedure 4.108. Edit a newsletter

1. In a specific subscription, select the newsletter you want to edit by selecting the checkbox.

2. Click

, then select Edit in the menu.

The Newsletter entry form will appear:
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3. Change the values in the fields that you want to edit: Template, Send date, Category,

Subscription.

4. Click the Update a Newsletter's info button.

5. Change the values in the fields Title and Main content.

6. Click Save to save as draft, or click Send.

4.10.2.5. Delete a newsletter

Administrator can delete obsolete newsletters.

Procedure 4.109. Delete a newsletter

1. In a specific subscription, select the newsletter that you want to delete by selecting the

checkbox.
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2. Click

, then click Delete in the menu.

The confirmation message will be displayed:

3. Click OK to accept deleting this newsletter, or Cancel to quit without deleting.

4.10.2.6. Convert as Template

The administrator can reuse the template of the frequently used newsletter template.

Procedure 4.110. Convert to template

1. Select the newsletter that you want to create as a template.

2. Click

, then select Convert as Template in the menu. The next time when you create a newsletter,

this template will be listed in the Template field in the Newsletter entry form.

4.10.2.7. Newsletters

Each subscription consists of many newsletters. WCM helps you easily create newsletters by

following these steps.

Procedure 4.111. Creating Newsletters

1. Go to Group > Newsletters  on the administration bar. The eXo Newsletter appears.

2. Click

on the action bar. The Newsletter entry formwill appear:
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Details:

Table 4.25.

Field Details

Template The template that you select for your

newsletter form.

Send date The date and time when you want to send

this newsletter.

Category The category contains this newsletter.

Subscription The subscription contains this newsletter.

Update sending parameters This button allows you to update information

about this newsletter.

3. Click

to select the template for the newsletter.

4. Click the Send Date field. The calendar will appear to allow you to choose the date and time

when you want to send the newsletter.
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5. Click

in the category field to select the category and the subscription in list.

6. Click the Update sending parameters button to update information about this newsletter. A

message pops up and informs you that you have updated information successfully.

7. Input a title of a newsletter into the Title field.

8. Create a content for a newsletter by inputting information into the Main content textbox.

9. Click Save to save this newsletter as draft, or click Send to send this newsletter.

10. Select Contact Us on the navigation bar, or go to Site > Acme > Contact Us.

The Contact Us page will appear:
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Table 4.26.

Field Details

Select a recipient The recipient who will receive a message

Your name The name of a person who leaves a

message

Your address The address of a person who leaves a

message

Your Email Address The email address of a person who leaves a

message

Your Phone Number The phone number of a person who leaves

a message

Your message Write a message that you want to leave

11. Select a recipient and enter values in this form.

12. Click Save to save a message.

4.11. Fast Content Creator

Site Publisher provides users with the Fast Content Creator portlet that allows users to create

document content quickly. The Fast Content Creator portlet is applied in the Contact Us portlet

on the navigation bar:

Procedure 4.112.

1. Go to Contact Us on the Navigation bar or go to  Site > Acme > Contact Us.
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The Contact Us page will appear:

Table 4.27.

Field Details

Select a recipient To choose people who will receive the

message.

Your Name To type the name of person who leaves a

message.

Your Address To type the address of person who leaves a

message.

Your Email Address To enter the email address of person who

leaves a message.

Your Phone Number To enter the phone number of person who

leaves a message.

Your Message To write a message that you want to leave.

2. Select a recipient and cokplete the other values in the form.

3. Click Save to send a message.

4.11.1. Edit Mode

Users can edit templates, take actions, and save locations for the documents in the Contact Us

portlet.
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Procedure 4.113.

1. Go to Contact Us on the Navigation bar or go to  Site > Acme > Contact Us.

2. Click Site Editor > Edit Page on the administration bar. The Page Editor will be displayed.

3. Click the edit icon to open the Edit Mode tab in the Contact Us portlet.

The Edit Mode tab appears:
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Table 4.28.

Field Details

Location to Save Select the location for saving documents or

messages.

Select Template Choose available templates for documents.

There are corresponding fields to each

template.

Custom Save button Change the label for the save button.

Custom Save message Show a custom message that informs you

have just saved a document.

Redirect Allow users to redirect the path in the

Redirect path field.

Redirect Path Show a path that a user will be directed to

after he/she clicks OK in the confirmation

message.

Actions Add another actions to documents.

4. Click the

to search for the location to save documents. The Select Location form appears:

5. Select the parent node on the left panel and click the
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in the Action column to choose the child node on the right panel. After being selected, this

location will be displayed on the Location to save field. Created documents will be saved

in this location.

6. Select a template for documents by clicking .

7. Change the label for Save, and the message content after clicking Save.

8. Select the Redirect checkbox if users want to redirect to the path in the Redirect path field

after clicking OK in the save message.

9. Click Save to save all changes of editing properties for documents that users will create in

the Contact Us Portlet.

4.12. Form Builder

The Form Builder portlet enables users to create and to edit template of document types.

Documents are stored in the so-called node; therefore, the term “node” and node types are often

applied.

Procedure 4.114.

1. Go to Group > Form Builder on the administration bar. The Form Builder will appear:

2. Enter the node name into the Name field. (* Required)

3. Enter a brief description about the node.

4. Click the Form Builder tab that allows you to set properties for a node. Available components

are displayed on the left pane.
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5. Click the desired components on the left pane. The selected components will be displayed

on the right pane.

6. Click the

corresponding to the component to move this component up or the

to move the component down.

7. Click the

that corresponds to the component to edit properties of that component. The form to edit

properties appears like the illustration below:
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Table 4.29.

Field Details

Field Label To enter the field label.

Width Enter the field width. If the checkbox in

is marked the

will appear beside the text box, indicating

that values in this box are required.

Height Enter the field height.

Default Value To display the default value

Guidelines for User To display instructions about this

component.

To delete the component, click the

corresponding to the component.

Click

again to hide the form to edit the properties.

After editing the properties of the components, the components look like the below illustration:
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8. Click Save to accept creating a new node, or Reset to edit this node again before saving

A message will inform that you created a node successfully.

4.13. Category Navigation

Category Navigation Portlet and Parameterized Content List Viewer portlet get rid of long URLs

when you view a content and help users see published documents or webcontents in specific

categories in one page. Thanks to the symbolic link, no matter where the object physically resides,

the database can retrieve it. In addition, the relations amongst shortcuts can be managed. Now,

you can view documents or web content in the Parameterized Content List Viewer in such an

easy way.

Procedure 4.115. Access to Category Navigation Portlet

1. Go to News on the navigation bar:
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The left panel lists all the categories containing documents or web contents.

The right panel displays the documents selected in the left pane.

2. Select a category that you want to view on the left, it will be shown on the right (only documents

or web content published are shown).

4.13.1. The Edit Modes of Category Navigation Portlet

Administrators can edit the Category Navigation portlet with the following process:

categorynavigation.png

Procedure 4.116.

1. Go to Group > Administration > Manage Pages on the Administration bar. The Manage

Pages will appear:
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2. Click

that corresponds with the Category navigation portlet to open the page for edit this portlet.

3. Click

to open a form with the Edit Mode to edit the portlet.
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4. Click

to select the repository for documents in the Repository field.

5. Input the name of a category in the Title field.

6. Select the tree name for a category.

7. Select the template for displaying categories.

8. Click the

icon to select the target path. The Page selector form will appear:

9. Click
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to select the navigation on the left pane. The corresponding pages will be displayed on the

left pane and the corresponding paths will be displayed on the right pane.

10. Click the

icon to select the path. This path will be displayed in the Show in page field.

11. Click Save to accept saving the configuration for the Category Navigation portlet.
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Advanced Actions

5.1. Set Up a Website

Note

In eXo Content, we use the 'Website' term equally to the 'Portal' term. It means that

creating a new portal is creating a new website. Thus, you can also edit, delete,

view a website as a portal.

However, only Administrators can create a new site.

5.1.1. Create a new site

This function enables you to create a site (portal) to meet your own needs.

Do the following:

(*): required

Table 5.1. Details:

Field Information

Portal name The name of the portal. This field is required

and must be unique. Only alphabet, numbers

and underscore characters are allowed. The

Portal name must be at least 3 characters.

Locale The interface language of the portal. This field

is required.

Skin The skin of the portal.

1. Click Site on the administration bar. A list of existing portals will be listed.
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2. Click the Add New Portal button to open the form to add a new portal. In the Portal Setting

tab, you can set some properties for this site.

3. Keep session alive by clicking the Properties tab.

The Keep session alive option means keeping the working session for a long time to avoid

the working time out. There are 3 options:

never:

It never happens even if the application requests.

on demand:

It starts to be used as soon as the application requests.

always:

It is always enabled.

4. Click the Permission Setting tab to set access and edit permission for this portal.

The Permission Setting tab includes two subtabs: Access Permission Setting and Edit

Permission Setting.
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Access Permission Setting tab

By default, the access permission list of the portal is empty:

Check the  Make it public  check box to assign the access permission to everyone, or

click the Add Permission  button to assign the access permission to a specific group

which is selected from the  Select Permissions form (By selecting a group on the left

and a corresponding membership on the right):

After selecting groups, the access permission list is displayed:
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In which, the icon

is to remove its corresponding group from the Access Permission list.

Edit Permission Setting

By default, it is also empty and you have to assign the edit permission to a specific group.

You can assign the edit permission to a group with a specific membership by clicking the

Select Permission  button in the Edit Permission Setting tab to open the Permission



Create a new site

221

Selector form. Select a group on the left panel and a corresponding membership on the

right panel:

The (*) from the Select a Membership panel means that you assign the right for everyone

in the selected group from left panel.

After selecting a group, the Current Permission will be displayed with detailed information:

The edit permission is assigned for only one group at one time. You can click the Delete

Permission button to remove the current edit permission of the selected group or re–

assign the edit permission to the another group by re-clicking the Select Permission

button and select another group.



Chapter 5. Advanced Actions

222

5. Click Save to accept creating a new portal.

After creating a new site, a list of the existing sites will be displayed on the screen. This new site

will be added in the exiting sites in Site  on the administration bar and concurrently in a drive that

includes all its default files.

To see it in the drive, click Group > Content Explorer on the administrator bar.

For example, after creating a portal named 'eXo', there is a drive named 'eXo' in Content Explorer:

5.1.2. Edit a Site

This function enables you to edit a site (portal). In addition to editing the configuration (setting,

access/edit permission) of a site like a portal, you also may edit the layout components of that site.

5.1.2.1. How to edit the current Site

To edit the current site that you are browsing, do the following:

Procedure 5.1. Edit the layout of the Website:

1. Show the form to edit the current site by clicking

Site Editor on the administration bar, then select

.
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2. The form to edit the current site will appear.

To edit the configuration and the layout of the current portal, use one of icons below:

Table 5.2.

Indicator Meaning

Site's config: allows editing the site's

configuration.

Switch View Mode: allows turning on the

view mode

Finish: allows saving all changes and

escaping the Edit page

Abort: allows canceling all changes that

have not been saved and quitting the Edit

page
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Edit layout: You can edit a banner, a navigation bar, a breadcrumb bar, a homepage and a

footer of a website. Also, you can add more portlets on the homepage or move a portlet from a

location to another location
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Procedure 5.2. Edit Banner

1. Show the form to edit a banner by clicking the icon

of

the banner portlet in the Edit Portal form like the illustration below.

A form to edit the current banner will appear:

2. Select Edit Mode tab:

Content Selection: Select the path of the content that you want to show by clicking +.

Display Settings:

• Show Title: Specify whether the title of the content is displayed or not.

• Show Date: Specify whether the date of the content publication is displayed or not.
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• Show Option Bar:Show or hide the Option bar used to show the print link.

Print Setting:

• Show in page: Choose a page for the print review.

• with: Parameters contains the content path.

Advanced: The content should enable “dynamic navigation” that interprets the URL and

shows a content.

Note

Click

to see more explanation for each section.

3. Select the Porlet Setting tab:

Details:

Table 5.3.

Display name The display name of the portlet. You cannot

change it.

Portlet Title The title of the portlet. You can change it.

Width The with of the portlet.
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Height The height of the portlet.

Show infor bar Tick the check box if you want to show the

infor bar of the portlet.

Show Portlet mode Tick the check box if you want to show the

portlet mode.

Show window state Tick the check box if you want to show the

window state.

Description Enter description about the portlet.

4. Select Icon tab: Select an icon for the portlet by clicking it.

5. Select Decoration Theme tab: Select a decoration theme for the portlet.

6. Select Access Permission tab:

By default, all users can access the portlet:

However, you can edit the access permission by unticking the checkbox > click Add

Permission:
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The ListPermissionSelector form appears. Select a group on the left pane and a

membership on the right pane.

Note

The * on the right pane means all members in the goup.

7. Click Save and Close to accept changing or Cancel to quit the form without changing.

8. Click

to quit the form to edit the current site.

Edit the current Site's configuration: To edit the configuration fo the current site. Click

to open the same form as the form to add a new portal. Do the same steps in the part Section 5.1.1,

“Create a new site”.

Note

You cannot change the name of the site.

5.1.2.2. How to edit an existing site

You can edit any existing sites in the list of sites. Here, you can edit the layout, configuration and

navigation bar of the site. Click Site to open the list of existing sites.
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Edit Layout. Do the following to edit the layout of an existing site.

1. Click Site > Edit Layout to open a form to edit the site layout .

2. Do the same steps as the part Edit layout:of the current site.

Edit Navigation. Do the following to edit the navigation of an existing site.

1. Click Site > Edit Navigation to open the Navigation Management form
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2. Click Add Node to open the ADD/EDIT PAGE NODE form.

3. In the Page Node Setting tab, enter a name for the node. It is required.
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Details:

Table 5.4.

Uri: The node's identification. The Uri is

automatically created once a new node has

been created.

Label: The node's display name on the screen. This

field may be changed and its length must be

between 3 and 60 characters.

Visible: This checkbox allows the page and its node

to be shown or hidden at the navigation bar,

the page navigation bar and the sitemap.

See above for more details.

Publication date & time: This option allows this node to be published

for a period of time. Two fields, including

'Start Publication Date' and 'End Publication

Date' only display when this option is

checked.

Start Publication Date: The start date and time to publish the node.

End Publication Date: The end date and time to publish the node.

4. Select the Page Selector tab:
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Details:

Table 5.5.

Page Id: The identification string of the page. It is

created automatically when the page is

created.

Name: The selected page's name.

Title: The selected page's title.

Clear Page: To remove the inputted page information in

the fields

Create Page: This is to create a new page with the inputted

name and the title.

Search and Select Page: This is to search and select an existing page.

• Enter a title for the page.

• Click Create Page to create a new page or Search and Select Page to select an existing

page for the node.

5. Select the Icon tab to choose an icon for the node. It is not required.

6. Click Save to accept creating a node for the navigation.

Note

You can edit/delete a node, edit a node's page, copy/cut a node and more by right-

clicking the node in the form Navigation Management form.
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Edit Properties. Portal properties such as language, skin and permissions can be edit by doing

the following:

1. Click Site > Edit Portal's Config to open the same form as the form to create a site.

2. Do the same steps in the part Section 5.1.1, “Create a new site”.

5.1.3. Switch between sites

This function is used to change the current web site by another one.

Procedure 5.3.

• Just select a site in the site list that appears when you move the cursor to Sites on the

Administration bar:

Your current site will be switched to the selected site, and you will see all the child pages that

displays on the Navigation bar of the selected site.

5.1.4. Delete a site

This function is used to delete a portal (site) from the portal list.



Chapter 5. Advanced Actions

234

Do the following:

Procedure 5.4.

1. Show the portal list by clicking Site on the Administration bar:

2. Click

in the row of the portal that you want to delete.

3. Click OK in the confirmation message to accept deleting.

5.2. Manage Site Resources in one place

You can easily manage all the site resources in Content Explorer.

Chose

in General drive. All of your created sites and their resources will be listed in the left panel.

All sites contain typical folders that are site resources:
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5.2.1. CSS Folder

CSS is one of default files of a site. This folder contains CSS data that is used to present data in

a site and increase that site's content accessibility.

CSS

Once a new CSS file in a site is created, it will affect on how the site will look. For

example, the color of the current site's background is black but when you create a

new CSS file with red background color, all site's background will be in red.

5.2.2. Document Folder

This folder contains all documents used in a site. When you want to add a new document for a

site, you also can put them outside this folder but you are recommended to put all documents in

this folder to manage all site's documents easily and conveniently.
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5.2.3. JS Folder

This is one of default files of a site. This file contains Java Script data that is used to make a site

more animated and more dynamic.

5.2.4. Links Folder

This file contains all links used in a site.

5.2.5. Media Folder

This folder contains all documents related to videos, images and sounds. It is divided into three

sub folders:

audio:

This folder contains sound data used in a site.

images:

This folder contains images used in a site.

videos:

This folder contains videos used in a site.

5.2.6. Web Content Folders

This folder contains all web content used in sites. You are suggested to put all web content files

here to make use (in case you need to reuse web content files for creating a new site) and manage

more flexibility.
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5.3. Administration page

This page is used to manage all workspaces, drives, node types, metadata, templates, queries,

etc. Only administrators can access the Administration page.

• Click Group > Administration on the administration bar:

The Administration page will appear:

This page enables you to access:

• Categories and Tags: includes Manage Categories and Manage Tags.

• Content Presentation: includes Manage Template, Manage Metadata, Manage Views,

Manage Drive.

• Content Types: includes Namespace Registry, Manage Node Type.

• Advanced Configuration: includes Manage Queries, Manage Scripts, Create an Action Type.

5.3.1. Categories and Tags

5.3.1.1. Manage Tags

Manage Tags enables you to manage tag styles. The tag style will be changed depending on the

number of documents in a tag.
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Go to Administration > Manage Categories > Manage Tags.

5.3.1.1.1. Edit

Tag manager tab enables you to edit the existing tags.

Do as follows:

Procedure 5.5. Editing existing tabs

1. Click the pen icon corresponding to the tag name which you want to edit in the Action column

to edit the tag style configuration. The Edit tag style configuration form will appear:
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Details:

Style name

Give the tag name. You cannot edit it.

Document Range

Give the number of document assigned to a tag. (*Required).

Html style

Include font-size, font-weight, colour, font-family, text-decoration. (*Required).

2. Change values in the fields: Style name, Document range. Html single

3. Click Update to save new changes, or Cancel to quit this form without changing.

Note

• You cannot edit the style name.

• The format of valid range must be: a..b with 'a', 'b' are positive integers. You

can use * instead of 'b' to indicate it is unlimited. For example, 0..2 (means 0-2

documents assigned to a tag), 10..* (means at least 10 documents assigned to

a tag).

• The 'Html style' text box cannot be empty: you can change values of font-size,

font–weight, color, font-family, text-decoration.
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5.3.1.1.2. Delete a tag style

An administrator can delete a tag style by clicking the trash icon that corresponds to the tag style

which he wants to delete. There will be a message which confirms the deletion:

Click OK to accept deletion, or Cancel to quit without deleting the tag style

5.3.1.1.3. Add a tag style

Furthermore, an administrator can add a new tag style as follows:

Procedure 5.6. Add a Tag Style

1. Click the Add style button. The Add tag style configuration form will appear:
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2. Input values in the fields: Style name, Document range, Html style, all of which are required.

3. Click Update to accept adding a new tag style, or Cancel to quit without adding a new tag

style.

5.3.1.1.4. Tag Permission Manager

The Tag permission manager tab helps a administrator set permissions regarding editing and

deleting public tags.

Procedure 5.7. Set Permission To Tag Management

1. Click the icon to select memberships in order to add a permission for those memberships.

The Select membership form will appear:

2. Select a group on the left and the corresponding membership on the right. The selected

membership will appear in the Memberships field:
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3. Click Save to accept adding a permission for the selected membership of the selected

group. The selected membership that has just been added a permission will be listed in the

Memberships column.

An administrator can also delete memberships that have been set permissions by clicking

the Delete icon relevant to that membership. A confirmation message will appear:

4. Click OK to accept the deletion, or Cancel to quit the form without deleting.
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5.3.1.2. Manage Taxonomy

A Taxonomy may be understood as a classification practice and science. It is used to sort

documents, aiming at facilitating searches. The Taxonomy management includes adding, editing

and deleting a taxonomy tree.

Go to Administration > Categories and Tags > Manage Categories.

5.3.1.3. Add a Taxonomy Tree

Perform the step in Adding a Taxonomy Tree to add a taxonomy tree.

Procedure 5.8. Adding a Taxonomy Tree

1. Click the Add Taxonomy Tree button to add a new taxonomy. The Add taxonomy tree form

will appear.
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2. Enter the taxonomy tree name in the Name field. (*Required).

3. Select the workspace you want to work with.

4. Select the home path by clicking the plus item. The Select Home Path form will appear:

5. Click the tick icon if you want to select the root path or click the arrow icon to go to the up

level path. Click the plus sign to expand the folder.
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6. Click the tick icon corresponding to the path that you want to select as a home path.

Click Reset if you want to reset values that have just been selected or Next to select

permissions for a taxonomy tree.

7. Click the

icon to select a user or the

icon to select memerships or the

icon to select everyone in order to set permissions. The user or memership that you have just

selected will be displayed in the User or Group field.

Then, check at least one of these below options to set rights for the selected user to

membership:

Read Right

The option is to select the read right or not.

Add Note Right

The option is to select the Add Node right or not.
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Set Property Right

The option is to select the Set Property Right or not.

Remove Right

The option is to select the Remove right or not.

8. Click Save to save all values, or Reset to change values that have just been set. After clicking

Save, click Next to go to the next step.

9. Enter the name for an action of the taxonomy tree in the Name field. (*Required).

10. Select values for Lifecycle, NodeTypes, Target workspace, Target path, Affected Node

Types. (*Required).

11. Click Save to save all values and, click Next to go to the next step.

Note

• Do not input some special characters in the 'Name' field like: !,@,#,$,%,&,*,(,).

• Do not add a taxonomy which has the same name and level with existing

taxonomies in a node.

• The taxonomy name must contain less than 30 characters.
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5.3.1.4. Edit a Taxonomy Tree

Perform the following steps to edit a taxonomy tree.

Procedure 5.9. Edit a Taxonomy Tree

1. Click the edit icon

that

corresponds to the taxonomy tree you want to edit.

2. Click the icon

to add more taxonomy trees. The Edit taxonomy tree will appear:

3. Enter a taxonomy name in the Taxonomy name field. (*Required).

4. Click Saveto save the taxonomy name.

5. Click Previous to return to the previous steps.
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6. Click Save to s ave all changes and the Previous or Next if you want to edit more.

Note

• You can delete a taxonomy by clicking the trash icon corresponding to the

taxonomy that you want to delete. Click OK on the confirmation message to

accept deleting this taxonomy, or click Cancel to discard this action.

• You cannot delete taxonomies that have been referenced.

5.3.2. Content Presentation Manager

5.3.2.1. Manage a Template

When creating a node in eXo Content, you must set its properties. Thus, each node needs to

have a form to enter data for their properties (called the dialog template), and display the existing

values (called the view template). The template management allows users to view, delete and

modify the predefined templates or to add a new template.

Figure 5.1. Manage Templates Form

Procedure 5.10. Add a New Template

1. Go to the Manage Templates form

Click Administration → Content Presentation → Manage Templates
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2. Open a new template form

Click the Add button in the Manage Templates form to open the Template form.

3. Select the template type

In the Name drop-down box, select the template type you require.

4. Label the template

Specify a name for the template in the Label field.

5. Specify whether the template is a document template

Click the Document Template check box if the template you are creating should be used

as a template for a document.

6. Open Permissions dialog.

Click the + icon next to the Permissions field to open the Select Permission dialog.

7. Assign memberships to the group

Select the group from the left panel and the membership from the right panel. Or you can set

permission for everyone by clicking the + icon next to Any Permission.

Figure 5.2. Select Permissions Dialog

8. Add dialog content

Select the Dialog tab and enter the value in the Dialog content field.
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Figure 5.3. Manage Templates Dialog Tab

9. Add view content

Select the View tab and enter the value in the Dialog content field.
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Figure 5.4. Manage Templates View Tab

10. Add CSS content

Select the CSS tab and enter the value in the Dialog content field.

11. Save template

Click Save to create the template.

Procedure 5.11. Edit a Template

1. Go to the Manage Templates form

Click Administration → Content Presentation → Manage Templates

2. Open the View and Edit Template form

Click the Pencil icon in the Action column corresponding to the template you want to edit.

3. Edit the Template tab

In the Template tab, you can edit the Label of the Template.
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4. Add a dialog to the Dialog tab

To add a dialog, do the following:

a. Input content for this dialog in the ' Content ' field.

b. Input name for this dialog. (*Required).

c. Select permissions for a group that can use this dialog. (*Required).

5. Edit an existing dialog in the Dialog tab

To edit an existing dialog, do the following:

a. Click the Pencil icon in the dialog row you want to edit.

b. Edit the dialog properties.

c. Click Save to accept all changed in the Dialog tab.

6. Delete an existing dialog

To delete an existing dialog, do the following:

a. Click the Trash Can icon in the dialog row you want to edit.

b. Click OK to continue with deletion.

Note

You can not delete the default dialog. You must create a new one before you

can delete the current default dialog.

7. Add a View to the view tab

To add a view, do the following:

a. Click the View tab and enter content into the content field.

b. Input name for this view. (*Required).

c. Select permissions for a group that can use this view. (*Required).

8. Edit an existing view in the View tab

To edit an existing view, do the following:
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a. Click the Pencil icon in the view row you want to edit.

b. Edit the view properties.

c. Click Save to accept all changed in the View tab.

Notes about Editing Views

You can not change the view name.

If you click is Enable Version checkbox, this view automatically increments

one version after you click Save. It is displayed at ' version' column in the

View tab.

If the dialog has at least two versions, in the View tab, it displays the Restore

button. You can use Restore to roll back to the previous View.

9. Delete an existing dialog in the Dialog tab

To delete an existing dialog, do the following:

a. Click the Trash Can icon in the dialog row you want to edit.

b. Click OK to continue with deletion.

c. Click Save to accept all changes.

Procedure 5.12. Delete a Template

1. Click the

corresponding to the template that you want to discard.

2. Click OK on the confirmation message to delete the template or Cancel to abort the operation.

5.3.2.2. Metadata Management

Metadata in its simplest form is "data about data". Generally, it may be understood as information

that describes, or supplements the central data. The metadata management allows managing

nodes in the metadata format in the WCM system. The metadata may be considered as

information used to describe the data. When data are provided to the end users, the metadata

allow users to understand about information in more details. All metadata nodes can combine with

other nodes to create a new node (add mix).
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Procedure 5.13. View Metadata

1. Go to the Manage Metadata form

Click Administration → Content Presentation → Manage Metadata

2. Open the Metadata Information form

Click the magnifying glass icon corresponding to the metadata you want to view.

The Metadata Information Form opens.

Figure 5.5. Metadata Form

Procedure 5.14. Edit Metadata

1. Open the Edit Metadata's Template form

Click the Pencil icon in the metadata row you want to edit.
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The Edit Metadata's Template form opens.

2. Change the properties

Change the required properties of the metadata.

Note

You cannot edit the metadata name.

3. Save changes

Click Apply to save all metadata changes.

Procedure 5.15. Delete Metadata

1. Click the Trash Can button

Click the Trash Can icon corresponding to the metadata you want to delete.

A confirmation message displays.

2. Confirm deletion

Click OK to delete the template, or Cancel to preserve the template.

5.3.2.3. Manage Views

The function Manage View is used to control view ways of a user. It has 3 tabs: View, ECM

Templates and BC Templates tabs.

To open the Manage View function, click Administration → Content Presentation → Manage

View. The Manage View form displays.
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Figure 5.6. Metadata Form

Views Tab. The procedures that describe how to Add, Edit, Delete, and Preview views.

Procedure 5.16. Add View

1. Open the Add View form

Click the Add View button located at the bottom of the Manage View form.

The Add View form opens.

2. Define View Name

In the Name field, specify the name of the view you are creating. The name must be unique,

and must only contain standard alphanumeric characters.

3. Assign memberships to the group

Select the group from the left panel and the membership from the right panel.
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Figure 5.7. Select Permission Dialog

4. Select the Templates view

Click the Templates field and select the correct template for this view.

5. Save the View

Click Save to apply all settings and close the form.

Procedure 5.17. Edit a View

1. Click the Pencil icon in the view row you want to edit.

2. Edit the view properties.

Notes about Editing Views

You cannot change the view name.

If you click the Enable Version checkbox, this view automatically increments

one version after you click Save. It is displayed at ' version' column in the

View tab.

If the dialog has at least two versions, in the View tab, it displays the Restore

button. You can use Restore to roll back to the previous View.
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3. Click the Add Tab button to open the Tab Form tab to add more tabs.

a. Click the Add Tab button to add more tabs after the initial tab has been added.

b. Click the Reset button to change values for fields.

c. Click the Back button to return to the View Form tab in the Edit View form.

4. Click Save to accept all changed in the View tab.

Procedure 5.18. Delete Views

1. Click the Trash Can button

Click the Trash Can icon corresponding to the view you want to delete.

A confirmation message displays.

2. Confirm deletion

Click OK to delete the view, or Cancel to preserve the view.

Note

You can not delete a view that is in use.

Procedure 5.19. Preview a View

1. Click the Magnifying Glass icon in the Action column of the view you want to preview.

The View form opens.
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Figure 5.8. View Dialog

2. Click Close to exit the View Form.
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5.3.2.3.1. ECM Templates

Figure 5.9. ECM Templates

Procedure 5.20. Add a new ECM Template

1. Select the ECM Templates tab.

2. Click the Add button to open the Add ECM Template form.
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Figure 5.10. The Add ECM Template form

3. Input the content of the template in the Content field.

4. Input a name for the template in the Name field.

5. Select a type for the template in the Template Type field.

6. Click Save to accept adding a new template, or click Reset to change values, or Cancel to

quit without any changes.

Procedure 5.21. Editing a Template

1. Click the Pencil icon next to the template you want to edit.
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Figure 5.11. Editing an ECM Template Form

2. Change the current template's properties.

3. Click Save to accept all changes, or Cancel to quit without any changes.

Note

You cannot edit the template name.

If you tick the 'Enable Version' checkbox, this template will automatically

increase to 1 version after you have clicked Save. It is displayed at the 'Base

version' column in 'ECM template' tab.

If the template has at least 2 versions, in the 'Edit ECM Template' form, it

displays the Restore button that allows restoring the template version.

Procedure 5.22. Delete a Template

1. Click the Trash icon corresponding with the template you want to edit. A confirmation

message will appear.
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2. Click Ok to accept deleting this template, or Cancel to discard this action.

5.3.2.3.2. BC Templates

Figure 5.12. BC Templates form

Procedure 5.23. Adding a New Template

1. Click Add to open the Add BC Template form.
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Figure 5.13. The Add BC Template form

2. Input the content for the template in the Content textbox. (*Required).

3. Input the name for the template in the Name field. (*Required).

4. Select the template type from the dropdown box in the Template Type form.

Figure 5.14. Dropdown Box

Note

The name must be unique.

The name must not contain special characters like !,@,#,$,%,&,*,(,).

5. Click Save to complete adding a new template.
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Procedure 5.24. Edit a BC Template

1. Click the Pencil icon on a template that you want to edit.

Figure 5.15. The Edit BC Template Form

2. Change the current template's properties.

3. Click Save to accept all changes, or Cancel to quit without any changes.

Note

You cannot edit the template name.

You cannot edit the template type.

If you tick the 'Enable Version' checkbox, this template will automatically

increase by 1 version after you have clicked Save. It is displayed at the 'Base

Version' column in ECM Template tab.

If the template has at least 2 versions, in the 'Edit ECM Template' form, it

displays the Restore button that allows restoring the template version.
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Procedure 5.25. Delete a Template

1. Click the Trash icon corresponding with the template you want to edit. A confirmation

message will appear.

2. Click Ok to accept deleting the template, or Cancel to discard this action.

5.3.2.4. Drives Management

The function supports to manage drives in the File Explorer. It allows adding, editing and deleting

drives.

Go to Administration > Content Presentation > Manage Drives.

5.3.2.4.1. Add a new drive

Use the  to add a new drive.

1. Click the Add Drive button in the Manage Drives form to open the Add Drive form.
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2. Input a name for the new drive in the Name field. (*Required).

3. Select a workspace for the drive. There are 4 available workspaces: system, collaboration,

backup, and dms-system.
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4. Select the home path for the drive by clicking the

icon

5. Click the

icon to select the home path.
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6. Select an icon for the workspace by clicking the

7. Click

to select an icon file:

8. Select permissions for groups that have access rights to this drive by clicking the

icon.

9. Select or unselect the various checkboxes to hide or show the corresponding drive elements:

Show referenced document

Allows viewing preference documents.

Show non-document

Allows viewing non-documents.

Show sidebar

Allows showing the sidebar.

Show hidden node

Allows showing the hidden nodes.

10. Select the document type that will be created in this drive:

Folder

Only nt:folder folders can be created in this drive.
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Unstructured folder

Only nt:unstructured folders can be created in this drive.

11. Click

to select a node type. The Select node types form will appear:

Enter a node name to search for in the Node type name field and click the

to begin searching.

All the node types matching the search string will appear in a list below.

Check the box correpsonding to the desired node type in the Select column, or click the

beside Choose all node types to select all results.

If you click the icon, the Allowance nodetype on left tree becomes a required field (indicated

by an asterix '*')

Click the

if you want to remove the selected nodetype.



Chapter 5. Advanced Actions

272

12. Select the Apply Views tab and select the view type you want to be available in the drive:

13. Click Save to commit the details and create the new drive, Refresh to clear the form or Cancel

to abort the operation.

Procedure 5.26. Edit a drive

1. Click the

icon that corresponds to the drive you want to edit. The Edit drive for will appear:
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2. Edit the properties as required.

3. Click Save to commit the changes.

Drive Name

The drive name can not be edited in this form.

Procedure 5.27. Delete a drive

1. Click the

that corresponds to the drive you want to delete.

2. Click OK on the confirmation message to delete the drive or click Cancel to abort the

operation.
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5.3.3. Content Types

5.3.3.1. The Namespace Registry

The namespace is used as a prefix for the node type that describes all the node type properties.

This function enables users to register the namespace used in the system.

Go to Administration > Content Types > Namespace Registry to open the NamesPace

Registry form.

Figure 5.16. Namespace Registry

Procedure 5.28. Registering a Namespace

1. Click the Register button on the Namespace Registry form to register a new namespace.

Figure 5.17. Namespace Registration Form
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2. Enter the value for the Namespace Prefix field. (* Required).

3. Enter the value for the Uri field. This field must be unique. (*Required).

Important

The namespace must not contain special characters like !,@,#,$,%,&,*,(,).

5.3.3.2. Manage Node Types

This function is used to control all node types in WCM.

Figure 5.18. The Manage Node Type Form

5.3.3.3. View Node Types

1. Click the icon that corresponds to the node to be reviewed. The View Node Type Information

form will appear.
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Figure 5.19. View Node Type Information Form

2. Click Close to exit this form.

Procedure 5.29. Add Node Type

1. Open the Add/Edit Node Type Definitions form by clicking the Add button on the Manage

Node Type Form.
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Figure 5.20. Add Node Type Form

2. Select a name space for the node. It looks like a node prefix.

3. Enter a node name for the Node type name field. This field is required, and must be unique.

Important

The name must not contain special characters like !,@,#,$,%,&,*,(,).

4. Select a value for the "Is mixin type" field.

• True: this node is mixin type.

• False: this node is not mixin type.

5. Select a value for the "Orderable child nodes" field:

• True: child nodes are ordered.

• False: child nodes are not ordered.

6. Enter a value for the Primary item name field.

7. Super Types: Click the + button to add more parent types.
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8. Property definitions: lists all definition names of Property tab.

9. Child node definitions: lists all definition names of Child node tab.

10. Click Save to accept adding a new node type, or Save draft to save this node type as a draft,

or Cancel to quit.

Procedure 5.30. Export Node Types

1. Open the Export Node Types form by clicking the Export button on the Manage Node Type

Form.

Figure 5.21. Export Node Types Form

2. Click Uncheck all if you do not want to export all node types. After clicking Uncheck all, this

button becomes the Check all button.

3. Select nodes that you want to export by ticking the checkboxes.

4. Click the Export button in this form.
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5. Select the location in your computer to save the exported node.

Important

You must select at least 1 node type to be exported. If you do not want to

export the node, click Cancel to quit this pop-up.

Procedure 5.31. Import Node Types

1. Open the Import Node Type from XML file form by clicking the Import button on the Manage

Node Type Form.

Figure 5.22. Import Node Type from XML file Form

2. Click the Browse button to upload a file.

Figure 5.23. Browse for XML files containing Node Types
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Important

You must upload an XML file. This file is in the node type's format.

3. Click the Upload button.

Note

If you want to upload a different file, click the trash icon to delete the file which

has just been uploaded, then upload other files.

4. Tick the checkboxes corresponding to the nodes that you want to import.

5. Click the Import button to complete importing a node type.

5.3.4. Advanced Configuration

5.3.4.1. Manage Queries

The function supports you to manage queries. It allows adding, editing and deleting queries.

Go to Administration > Advanced Configuration > Manage Queries.
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Procedure 5.32. Add a new query

1. Show the Add Query form by clicking the Add Query button in the Manage Queries form.

2. Enter a query name for the Name field.

3. Select the query type.

• Xpath: (XML Path Language) is a language for selecting nodes. For example, /jcr:root/

Documents/Live

• SQL: (Structured Query Language) is a database computer language.

4. Enter the statement for query. The name of node type must be unique.

5. Check or uncheck the 'Enable cache results' option. If you tick this checkbox, for the fist time

you use this query to search, the result will be cached. For the second time you search using

this query, it will show the cached results. After 45minutes, the cache will be removed.

For example: you have the query Test with statement //element (*, nt:file). In the File

Explorer, you have a nt:file document named File1. When you execute the query Test,
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only document File1 will be shown. After that, create a nt:file document named File2

and execute query Test, only document File2 document will be listed. After 45 minutes, the

cache will be removed. When you execute the query Test, the documents File1 and File2

will be listed.

6. Select permissions for a group that can use this query by clicking

7. Click Save to finish adding a new query.

Procedure 5.33. Edit a query

1. Click the

icon corresponding to the query you want to edit. The Edit Query form will appear:



Advanced Configuration

283

2. Edit the properties of the selected query.

3. Click Save to accept all changes.

Procedure 5.34. Delete a query

1. Click

corresponding to the query you want to delete. A confirmation message will appear.

2. Click OK to accept deleting this query, or Cancel to discard this action.

5.3.4.2. Manage Scripts

The function enables users to manage all script codes in the WCM and Browser Content system.

Go to Administration > Advanced Configuration > Manage Scripts.
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Details:

• WCM Scripts: scripts are used in WCM

• BC Scripts: scripts are used in Content Browser.

The ECM Scripts tab:

Procedure 5.35. Add a new script in ECM

1. Select ECM Scripts tab in the Manage Script.

2. Click the Add button to open the Add/Edit script form:
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3. Enter a value for the Script content field.

4. Enter a script name for the Script name field.

• The script name must be unique.

• The name must not contain special characters such as !,@,#,$,%,&,*,(,).

5. Click Save to accept adding the new script.

Procedure 5.36. Edit an ECM script

To edit an ECM script, do the following:

1. In the ECM Scripts tab, click the

icon that corresponds to the script that you want to edit. The Add/Edit script form will appear:
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2. Edit the properties in this form.

3. Click Save to save all changes.

Procedure 5.37. Delete an ECM script

To delete an ECM script, do the following:

1. In the ECM Scripts tab, click

on the script that you want to delete. A confirmation message will appear.

2. Click OK to accept deleting this action, or Cancel to discard this action.

The BC Scripts tab:
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Procedure 5.38. Add a BC script

To add a BC script, do the following:

1. In the Manage Scripts, select the BC Scripts tab.

2. Click Add to open the Add/Edit script form:

3. Input script content for the Script content field.

4. Input a script name into the Name field.

5. Click Save to finish adding the new script.

Procedure 5.39. Edit a BC script

To edit a BC script, do the following::
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1. In the BC Script tab, click

on a script that you want to edit.

The Add/Edit script form will appear:

2. Edit the properties that you want.

3. Click Save to accept all changes.

Procedure 5.40. Delete a BC script

To delete a BC script, do the following:

1. In the BC Scripts tab, click

on the script you want to delete. A confirmation message appears.

2. Click OK to accept deleting this script, or Cancel to discard this action.
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5.3.4.3. Manage Unlocks

All locked nodes are listed and managed by administrators in the Administration page. There

are two ways that help administrators unlock nodes: unlock nodes in the right-click the menu in

Content Explorer or unlock nodes in the Administration page.

Procedure 5.41. Unlock Nodes

1. Go to Administration on the navigation bar.

2. Select Advanced Configuration > Manage Unlocks on the Manage the main ECM

functions pane on the left. The locked nodes will be listed on the right panel.

3. In the Locked Node tab on the right panel, administrators can unlock nodes by clicking

that corresponds to nodes which need to be unlocked. The unlocked nodes will disappear

from the locked node list.

Administrators can manage and add the unlock permission for another group and users in

the Manage Lock tab.

4. Select the group on the Select group panel and the corresponding membership

on the Select membershippanel. The selected group will be lisetd in

the Group and Users column. However, administrators can also click the

if they want to allow any users to unlock nodes.
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5. In case, administrators want to remove the unlock permission of groups, click the

that corresponds to the group in order to remove them form the Unlock permission list except

the group *:/platform/administrator and root.

5.3.4.4. Create Action Types

This function allows managing of all action nodes in the eXo Content.

Procedure 5.42. Create an Action Type

1. Go to the Sites Administration on the navigation bar.

2. Select Advanced Configuration > Create an Action Type.
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3. Click the Add button to open the Action Type Form form:

4. Select the action type.

5. Input a name for the action.

6. Check/uncheck the "is Action Move" option: the action will have exo:move property or not.

7. Select an execute for the Execute field.
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8. The Variables field: allows creating multi-values for action.

If you want to add more values for action, click

. Click

to delete a value.

9. Click Save to accept adding a new action type.
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Next Steps
This user guide has provided a thorough explanation of features and terminologies within eXo

Content. Now that you know how to create, manage and publish web content and administer a

website based on eXo Content, you may have more questions or want to get involved in the eXo

community. The following links can connect you with resources to learn more and contribute to

the open source development process.

• Learn more about eXo Platform 3.0 [http://www.exoplatform.com/company/public/website/

platform]

• Video demos, tutorial and more in the eXo Resource Center [http://www.exoplatform.com/

company/public/website/resource-center]

• Access another eXo documents in the eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/

Main/WebHome/]

• Ask question about eXo Content in the Forums [http://forums.exoplatform.org/portal/public/

classic/forum]

http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://forums.exoplatform.org/portal/public/classic/forum
http://forums.exoplatform.org/portal/public/classic/forum
http://forums.exoplatform.org/portal/public/classic/forum
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Appendix A. Revision History
Revision History

Revision 1-2.1.1 Fri Nov 19 2010 ScottMumford<smumford@redhat.com>

Updated docbook source to WCM 2.1.1

Revision 1-2.0 Mon Oct 25 2010 ScottMumford<smumford@redhat.com>,

LauraBailey, TomWells,

EslpethThorne,

RebeccaNewton, JaredMorgan

Completed docbook conversion.

Revision 1-0 Tue Sep 28 2010 ScottMumford<smumford@redhat.com>

Initial creation of book by publican
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